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THE ESSENTIAL GUIDE TO DREAMWEAVER CS4 CSS, AJAX AND PHP

O Dreamweaver CS4 tem um novo visual. A primeira vista, as mudancas po-
dem parecer superficiais: um leiaute padrao de painéis levemente diferente e
fardado de cinza carvao. O programa agora compartilha da mesma interface
de usuario (Ul) dos outros programas da Creative Suite, tornando mais facil
para os designers criarem seu design basico no Photoshop ou lllustrator, e
entao prepara-lo para a Web no Dreamweaver.

Apesar das mudancgas na Ul serem importante, é sua funcionalidade fun-
damental que realmente importa e é nisto que o Dreamweaver CS4 mudou
dramaticamente. Novas funcbes, como Related Files, Live view e o Code
Navigator, fazem desta a versdo mais significativa do Dreamweaver desde o
Dreamweaver MX em 2002. As mudangas visam ajudar tanto os designers
quanto os programadores, e provavelmente terao um grande impacto no fluxo
de trabalho dos atuais usuarios. Seja vocé um novato no Dreamweaver ou um
ancido, para obter o melhor do programa, vocé precisa encontrar seu proprio
caminho através da Ul e das novas fungdes.

Neste capitulo vocé aprendera:
m Utilizar da OWL 2.0 Ul
m Alterar os painéis para os modos iconicos
m Converter o painel Insert em uma barra Insert com abas

m Utilizar a funcao Related Files para editar arquivos conectados a pagina
web

m Selecionar opgdes para a visualizagao Split
m Pré-visualizar paginas dentro da janela Document com o Live view
m Navegar diretamente as regras de estilo com o Code Navigator

m Editar marcacoes HTML e Cascading Style Sheets (CSS) com o renovado
Property inspector

Outra mudanga importante no Dreamweaver CS4 é que o Bridge e o Device
Central se tornaram componentes opcionais. O Bridge é um poderoso organi-
zador de arquivos (como um Windows Explorer ou Mac Finder com esterdides).
Ele possui muitas funcoes projetadas para agradar aos designers e fotégrafos,
como pré-visualizagao de arquivos, gerenciamento por palavras chaves e me-
tadados. O Device Central permite que vocé veja como ficara seu website em
diversos dispositivos portaveis. Tanto o Bridge quanto o Device Central sdao
integrados com outros programas da Creative Suite, mas muitos usuarios do
Dreamweaver estavam infelizes por ndo terem a escolha de instala-los ou nao
nas versoes anteriores. A Adobe escutou suas reclamagodes e tornou opcionais
muitos dos programas inclusos no Dreamweaver CS4. Entretanto, um progra-
ma opcional que vocé deve instalar € o Extension Manager, que é utilizado
para instalar extensdes que adicionam caracteristicas e funcionalidades ex-
tras ao Dreamweaver. Irei mostrar a vocé como utilizar o Extension Manager no
Capitulo 8, mas a énfase principal deste livro, claro, € no Dreamweaver CS4.

Este capitulo cobre as mindcias da interface do Dreamweaver. Foi escrito ten-
do em mente tanto os novatos quanto os veteranos. Se vocé estiver atuali-
zando a partir de uma versao anterior do Dreamweaver, muitas coisas serao
instantaneamente familiares; a Ul € uma mistura sutil de velho e novo. Entre-
tanto, mesmo quando as coisas parecem iguais, normalmente elas funcionam
de forma levemente diferente. Por exemplo, pressionar F4 ainda esconde a
maioria dos painéis, mas mover seu mouse para a borda da tela traz de volta
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qualquer coisa escondida naquele lado (leia “Escondendo temporariamente
0s painéis,” se quiser desabilitar este comportamento). Por haver tantas fun-
coes na Ul, vocé pode querer passar rapidamente por este capitulo para ver o
que ele contém e retornar mais tarde quando precisar descobrir como funcio-
na uma caracteristica em particular.

Vamos comecgar com uma visao geral da interface do Dreamweaver CS4.

Explorando a Ul

A interface comum compartilhada por todos os programas do Adobe Creative
Suite 4 é oficialmente conhecida como OWL 2.0. OWL significa OS (sistema
operacional) Widget Library. A OWL nao apenas oferece uma funcionalidade e
aparéncia comum aos programas do CS4, mas também elimina a maioria das
diferencas na forma como cada programa funciona no Windows e no Mac 0OS
X. Com apenas algumas excegdes menores, a versao para Mac do Dreamwea-
ver agora se parece e funciona de forma idéntica a sua versao para Windows.

Inspecionando o espaco de trabalho padrao

A éarea de trabalho do Dreamweaver CS4 é infinitamente configuravel e vocé
pode salvar seus proprios leiautes. As figuras 1-1 e 1-2 mostram o que recebe
vocé quando abre pela primeira vez o programa no Windows e no Mac 0S X,
respectivamente.

A Unica diferenca importante entre as duas versoes € que a versdo do Mac
mantém os menus principais do Dreamweaver na barra de menu do Mac, en-
qguanto eles estdo integrados a nova barra do aplicativo no Windows; e a ver-
séo do Windows cobre a Area de Trabalho, enquanto a versdo do Mac permite
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Figura 1-1. O leiaute padrao quando o Dreamweaver CS4 é aberto pela primeira vez no
Windows.
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Figura 1-2. A versao para Mac do Dreamweaver CS4 é quase idéntica a versao do Win-
dows.

que a Area de Trabalho seja vista quando nenhum documento esta aberto na
area de trabalho.

A versdo Mac de alguns dos outros programas do Creative Suite 4, como o Flash,
simulam o comportamento do Windows adicionando um fundo cinza em todo o pro-
grama. Entretanto, esta funcédo (conhecida como moldura de aplicativo) ndo foi im-
plementada no Dreamweaver.

A tela de boas vindas no centro da area de trabalho mostra uma lista das Ulti-
mas dez paginas abertas recentemente e fornecem atalhos para a abertura de
novos documentos dos tipos de arquivos utilizados mais comumente. Claro, a
lista de paginas recentemente abertas esta vazia na primeira vez em que vocé
abre o programa.

A primeira coisa que a maioria dos usuarios experientes do Dreamweaver faz
ap6s instalar uma nova versdo do programa € selecionar a opgdo Don’t show
again na parte inferior esquerda da tela de boas vindas. Mesmo que vocé sinta-
se tentado a fazé-lo nesta ocasiao, eu sugiro que vocé siga os links Top Features
(videos) na parte direita da tela. Estes abrem os videos da Adobe TV (http://
tv.adobe.com/) explicando e demonstrando as novas fungoes principais do Drea-
mweaver CS4. Como dizem, uma imagem vale por mil palavras, entdo os videos
devem lhe dar uma introducéo rapida as poderosas fungdes novas do progra-
ma. Vocé precisa estar conectado a Internet para visualizar os videos. Se vocé
ja tiver ocultado a tela de boas vindas, vocé pode restaura-la selecionando Edit
» Preferences (Dreamweaver » Preferences no Mac), selecionando a categoria
General e colocando uma marca de verificacao ao lado de Document options:
Show Welcome Screen.

Para ativar todos os painéis, vocé precisa abrir um documento. Se vocé for
novo no Dreamweaver, clique em HTML sob o titulo Create New na tela de boas
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Figura 1-3. O espaco de trabalho padrao Designer no Dreamweaver CS4

vindas. O leiaute de espaco de trabalho padrdo é chamado de Designer. A Fi-
gura 1-3 rotula todas as partes principais da area de trabalho, e a Tabela 1-1
fornece uma descri¢ao rapida destas partes. (Sendo que a Ul é quase idéntica

Tabela 1-1. Os elementos principais da area de trabalho do Dreamweaver

Funcao Descricao

Barra do Aplicativo No Windows, esta contém todos os menus principais do Dreamweaver além de
quatro menus comuns ao Windows e ao Mac, e o campo de Busca por Ajuda.
Os menus em comum controlam o leiaute da janela do documento, extensdes
do Dreamweaver, gerenciamento de site e leiaute do espaco de trabalho. A
barra do aplicativo pode ser fechada no Mac, mas é permanente no Windows.

Seletor de Espaco de Isto permite que vocé escolha entre nove leiautes de espaco de trabalho

Trabalho pré-definidos. Também tem opcdes para restaurar o leiaute atual e gerenciar
leiautes personalizados. Isto fica oculto no Mac caso a barra do aplicativo seja
fechada.

Busca por Ajuda Além do menu Help, agora vocé pode buscar ajuda diretamente na Ul. Digite

um termo de busca e pressione Enter/Return. Se vocé estiver conectado a
Internet, isto abre o website Adobe Community Help, que mostra o resultado
nao apenas para o website da Adobe, mas também para sites de blogs e tuto-
riais comunitarios selecionados. Caso vocé esteja off-line, o resultado vem dos
arquivos de ajuda locais do Dreamweaver. Isto fica oculto no Mac caso a barra
do aplicativo seja fechada.

Barra de Ferramentas Isto controla a visualizacdo do documento atual na janela do documento,

do Documento mostrando o leiaute da pagina, o cdigo base ou uma combinacédo de ambos.
Também contém um ndmero de ferramentas para pré-visualizacao da pagina,
upload para o servidor remoto e a verificagao de erros no codigo.

(Continua)
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Tabela 1-1. Continuacdo

Funcao

Descricao

Janela do Documento

Seletor de Tag

Property inspector

Barra de Status

Grupos de painéis

Esta é a area de edicao principal. Cada documento é aberto em uma aba sepa-
rada.

Isto mostra onde a selecao atual esté dentro da arvore estrutural do documen-
to. Pode ser utilizado para selecionar elementos da pagina e adicionar atribu-
tos, como uma ID ou classe, a uma tag.

Esta é a central de controle principal do Dreamweaver para se trabalhar com o
c6digo base enquanto se visualiza a pagina web na janela do documento. E um
painel sensivel ao contexto que mostra todos os atributos principais da selegao
atual prontos para edigdo. Uma mudanga importante das versoes anteriores
do Dreamweaver é a separagao do Property inspector em duas visualizagoes:
HTML e CSS. O acesso a estas visualizagoes € controlado por dois botdes na
parte superior esquerda do Property inspector.

Esta mostra os detalhes da janela do documento e da pagina atual, como am-
pliacdo, dimensdes, tamanho em kilobytes e codificagao.

Controles de painéis especializados em diferentes aspectos das paginas web,
como estilos, conexdes com bancos de dados (com uma linguagem do lado do
servidor como PHP) e arquivos no site atual (a definicdo do site é coberta no
Capitulo 2). Os painéis utilizados mais comumente sdo mostrados como uma co-
luna no lado direito da tela, mas podem ser rearranjados, minimizados ou fecha-
dos para se adequarem ao seu fluxo de trabalho, como descrito neste capitulo.

tanto no Windows quanto no Mac, todas as telas deste livro foram capturadas
na versao Windows, exceto quando existam diferencas importantes).

Isto parece muito familiar para usuarios de longa data do Dreamweaver. A prin-
cipal diferenga esta no grande painel na parte superior direita da tela. Este é o
painel Insert, que era uma barra de ferramentas muito mais compacta nas ver-
sOes anteriores. Ele foi redesenhado com rétulos ao lado de cada icone para
ajudar os novatos no programa a encontrarem facilmente as ferramentas. A
outra grande mudanca é que todos os icones no painel Insert estdo em tons
de cinza e mostram cores quando vocé passa o0 mouse sobre eles. A légica por
tras disto é reduzir a poluicdo cromatica - a teoria é que os icones coloridos
distraem vocé do design principal na janela do documento. Se vocé nao gostar
de qualquer destes padroes, eles podem ser mudados.

Eu irei lidar com o painel Insert (incluindo restaurar a barra Insert com abas
das versoes anteriores) na segao “Utilizando e configurando o painel Insert”
mais tarde neste capitulo, mas alterar para icones coloridos € algo que vocé
pode querer fazer imediatamente.

Alternando entre icones coloridos e em tons de
cinza

A idéia de reproduzir todos os icones em tons de cinza faz muito sentido em
programas de design grafico, como o Photoshop ou o lllustrator, pois eles pos-
suem barras de ferramentas relativamente escassas e abrandar os icones
permite que vocé se concentre no design com um minimo de distracdo. O
Dreamweaver, por outro lado, possui diversos icones, muitos deles muito pe-
quenos. Sem as cores para agirem como uma dica visual, as versoes em tons
de cinza podem ser dificeis de se distinguir, desacelerando o fluxo de trabalho.
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Entretanto, reconhecendo as diferentes formas das pessoas trabalharem, trés
dos leiautes de espaco de trabalho pré-definidos (Classic, Coder e Coder Plus)
mostram icones coloridos por padrao, e vocé tem a opcao de ativar os icones
coloridos em todos os leiautes. Ha trés formas de fazé-lo, como segue:

m Selecione View » Color Icons.

m Cligue com o botao direito sobre o painel Insert e selecione Color Icons a
partir do menu contextual (uma pagina precisa estar aberta na janela do
documento antes de vocé poder fazer isto).

m Clique no botao View options na barra de ferramentas do documento e se-
lecione Color Icons (veja a secao “Explorando a Barra de Ferramentas do
Documento” mais tarde, neste capitulo, para uma descri¢cao das funcoes
da barra de ferramentas do documento).

Escolhendo um leiaute pré-definido de espaco de
trabalho

Além do leiaute de espacgo de trabalho padrdao Designer, o Dreamwe-

~ . B o DESIGNER 1| [°
aver CS4 vem com outras sete opgoes de leiaute pré-definidas. Ese ., Dﬁm |
vocé nao gostar de nenhuma delas, pode criar e salvar seus proprios = agp peveloper Plus :
leiautes pessoais (como explicado na se¢ao “Gerenciando espagos = Classic

Coder

de trabalho” mais tarde neste capitulo). Vocé acessa os leiautes pré- -
oder Flus

definidos e gerencia os personalizados através do Seletor de Espaco T

Designer

de Trabalho (no Windows, ele estd na extremidade direita da Barra Designer Compact 1
do aplicativo; na versdo do Mac, estd muito mais para a esquerda). Busliicesn
A Figura 1-4 mostra as opgdes disponiveis no Seletor de espago de :JEt\ﬂDkg e
ew Workspace..,
trabalho Manage\f."oprk:pace:‘.. mage
A Tabela 1-2 fornece uma descri¢ao rapida dos leiautes pré-definidos, [Gr- et
mas a melhor forma de entendé-los é experimentar selecionando um
de cada vez. Figura 1-4. O Seletor de espaco

de trabalho oferece uma gama
de opcdes de leiaute maior que
nas versoes anteriores.

Tabela 1-2. Leiautes de espaco de trabalho pré-definidos no Dreamweaver CS4

Leiaute Grupos de painéis Descricao

App Developer Databases, Bindings, Server Os grupos de painéis séo mostrados
Behaviors, Files, Assets, completamente expandidos em uma coluna
Snippets a esquerda. A janela do documento a direita

é dividida horizontalmente para mostrar a
visualizagcao Code no topo e Design na parte de
baixo. O Property inspector é fechado. Adequada
principalmente ao desenvolvimento de websites
dindmico com tecnologia do lado do servidor.

App Developer Plus ~ Os mesmos de Apps Trés painéis relacionados ao design séo

Developer, mais Insert, CSS adicionados no modo icdnico a direita da

Styles, AP Elements, Properties  janela do documento (o painel AP Elements
mostra detalhes dos elementos que utilizam
posicionamento absoluto). O Property Inspector
é mostrado abaixo da janela do documento. Nao
adequado para monitor pequeno.

(Continua)
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Tabela 1-2. Continuacao

Leiaute Grupos de painéis Descricao
Classic Insert, Properties, CSS Styles, Este € o mesmo leiaute do Dreamweaver CS3.
AP Elements, Tag Inspector, 0 painel Insert € convertido a uma barra de
Databases, Bindings, Server ferramentas no topo da tela. O Property inspector
Behaviors, Files, Assets, esta na abaixo da janela do documento e os
Snippets grupos de painéis totalmente expandidos, a
direita. icones sdo mostrados coloridos. Um
leiaute versatil para desenvolvedores envolvidos
tanto no desenvolvimento do lado do servidor
quanto no design da pagina.
Coder Files, Assets, Snippets Este € um leiaute minimalista para
desenvolvedores que preferem trabalhar no
codigo puro. Apenas um grupo de painéis é
mostrado totalmente expandido a esquerda, com
a janela do documento na visualizagdo Code a
direita. O Property inspector é fechado. icones
sao mostrados em cores.
Coder Plus O mesmo que Coder, mais Este adiciona trés painéis relacionados ao
Insert, CSS Styles, AP Elements  design no modo iconico a direita da janela do
documentos. Os icones sdo mostrados em cores.
Designer Insert, Properties, CSS Styles, Este € o leiaute mostrado na figura 1-3. Fornece
AP Elements, Files, Assets as ferramentas basicas para o desenvolvimento
de websites estaticos. Uma boa escolha para
iniciantes.
Designer Compact O mesmo que Designer Este leiaute € igual ao Designer, mas os painéis
sao mostrados no modo iconico.
Dual Screen Insert, CSS Styles, AP Isto parte a Ul, mostrando prontamente quase

Elements, Databases, Bindings,
Server Behaviors, Assets,
Snippets, Files, Properties,
Code Inspector

todos os painéis disponiveis para redistribuicao
em uma configuragao com dois monitores. O
Property Inspector esta inicialmente anexado

a janela do documento, mas como tudo mais,
pode ser desanexado. E mais como um ponto de
partida para um leiaute personalizado, ao invés
de alguma coisa que vocé realmente utilizaria
regularmente.

Se vocé é um usuario experiente do Dreamweaver e simplesmente quer voltar a Ul ao
seu leiaute anterior, selecione Classic no Seletor de espaco de trabalho. Entretanto,
as novas opg¢oes podem fazer muito para melhorar seu fluxo de trabalho, entao vale

a pena explora-las.

Expandindo e fechando os painéis verticalmente

Como vocé pode ver nas Figuras 1-1 até 1-3, os painéis Insert e Files estdo
abertos no espaco de trabalho Designer padrao, mas os dois painéis no meio
(CSS Styles e AP Elements) sao mostrados apenas como abas. Todos os pai-
néis podem ser expandidos verticalmente para dar acesso ao seu contelido e
fechados em abas para conceder mais espaco para visualizar os conteddos

de outro painel.
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O AP em AP Elements significa “absolutamente posicionado.” O painel mostra de-
talhes de todos os elementos da pagina que possuam a propriedade CSS position:
absolute.

A forma como vocé expande um painel que é atualmente mostrado apenas
como uma aba depende de sua posi¢cdo. Se a aba for a da frente do grupo,
vocé precisa dar duplo-clique sobre ela. As outras abas abrem com um Gnico
clique de mouse. Para contrair um painel a sua aba, dé duplo clique na aba
ou clique uma vez na area cinza-escuro a direita da Ultima aba do grupo. Pai-
néis que estao agrupados juntos se expandem e contraem como um grupo.
Clicar uma vez na area cinza-escura também expande um grupo fechado de
painéis.

Muitos painéis também possuem atalhos de teclado para expandir e contrair.
Abra o menu Windows para ver os atalhos disponiveis ao seu sistema opera-
cional.

Redimensionando painéis

Painéis podem ser dimensionados vertical ou horizontalmente clicando e ar-
rastando no topo, parte inferior, laterais do painel ou grupo de painéis. O Drea-
mweaver memoriza o novo tamanho até que vocé mude-o novamente.

Utilizando painéis no modo iconico

Os usuarios de longa data do Dreamweaver

comecarao a ver as verdadeiras diferencas na | DESIGNER COMPACT = | [~ | |
Ul selecionando um dos leiautes de espaco 5 [T
de trabalho que utilize 0 modo iconico, como . ‘&, % [ checkPage & msesr
Designer Compact. Os grupos de painéis sao ;

idénticos ao leiaute Designer, mas ao invés dos iy cossTvies
grupos de painéis estarem totalmente expandi- B e eLements
dos (como na Figura 1-3), eles estao fechados

em icones com rétulos ao lado, como mostrado aku s

na figura 1-5. Bl assers
Clique em um icone ou seu rétulo e o painel _

surge, como mostrado na figura 1-6. Uma vez
aberto o painel, vocé pode redimensiona-lo ar-
rastando seus lados ou cantos. O Dreamweaver
memoriza este tamanho até que vocé o altere
novamente. Apenas um painel pode ser aberto por vez e por padrao, o painel
desaparece tao logo vocé clique em qualquer lugar fora dele. Isto significa que
vocé pode alternar rapidamente entre os painéis clicando no icone ou rétulo
do painel que quer acessar. Isto também enxuga o espaco de trabalho man-
tendo os painéis fora do caminho tdo logo vocé comece a trabalhar na janela
do documento.

Figura 1-5. Os painéis do Dreamweaver agora podem ser
fechados em icones.

Caso este desaparecimento automatico ndo seja adequado ao seu modo de
trabalhar, vocé pode desabilita-lo clicando com o botdo direito em qualquer
um dos icones de painéis e selecionando Auto-Collapse Iconic Panels a partir
do menu contextual. Um marca de verificacao ao lado desta opcao indica que
o desaparecimento automatico esta ativado. Clicando na opgdo no menu con-
textual vocé ativa e desativa este comportamento.
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Figura 1-6. No modo iconico, o painel surge com seus icones.

0 modo icOnico é particularmente Gtil em monitores pequenos, mas usuarios
do Windows podem se chatear com a vasta expansao de espaco cinza abaixo
dos icones (no Mac, a Area de Trabalho é vista). Ha duas coisas que vocé pode
fazer sobre isto tanto no Windows quanto no Mac:

m Minimizar os icones para esconder seus rétulos;

m Flutuar os icones.

Minimizando os painéis iconicos

Uma vez familiarizado com os icones dos painéis, vocé pode economizar espa-
¢o posicionando seu cursor sobre a margem de uma coluna no modo iconico
até que ele se transforme em uma seta com duas pontas. Segure pressionado
0 botdo esquerdo do mouse, e arraste em direcdo a margem oposta da coluna

até que os rotulos desaparecam e os icones travem em sua forma minimizada,
como mostrado na Figura 1-7.

Os icones minimizados funcionam da mesma forma que antes. Para ajudar
a lembra-lo do que cada icone representa, o Dreamweaver mostra uma dica
quando vocé flutua o mouse sobre um deles.

ﬁl INSERT

B cssstvies

Posicione o cursor
sobre a margem AP ELEMENTS
do painel icénico
e arraste para
minimizar.

Figura 1-7. Os painéis podem ser reduzidos a icones para economizar espaco.
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Figura 1-8. Os painéis minimizados podem flutuar em qualquer lugar do espaco de tra-
balho.

Apesar disto economizar espaco, vocé ainda tem a barra cinza no Windows,
ou a Area de Trabalho no Mac. Se vocé nao gostar disto, pode transformar os
painéis em uma barra de ferramentas vertical flutuante.

Convertendo painéis iconicos em barras de ferramentas
flutuantes

Vocé pode desconectar uma coluna de painéis iconicos clicando em qualquer
lugar da faixa cinza-escuro no topo da coluna e entao a arrastando para longe
da borda da tela. (Nao clique na seta dupla no topo direito - ela expande todos
0s painéis na coluna para sua largura padrao.) Uma vez que os painéis tenham
sido desconectados da margem da tela, vocé pode posiciona-los onde quiser.
Enquanto arrasta-los, eles ficam semitransparentes para tornar mais facil a
decisado de onde coloca-los. Como uma barra de ferramentas independente, os
icones ocupam o minimo de espaco, e a coluna cinza desaparece no Windows.
A Figura 1-8 mostra os painéis minimizados flutuando ao lado de parte de uma
pagina web na janela do documento.

Fechando e restaurando painéis flutuantes

0 Dreamweaver adiciona um botdo de fechar a faixa cinza-escura no topo dos
painéis flutuantes. A Figura 1-9 mostra os botdes de fechar adicionados a uma
barra de ferramentas flutuante de icones minimizados no Windows e no Mac.
0 botéo fechar segue a convencao do sistema operacional, entédo ele perma-
nece na parte superior direita ou superior esquerda quando os icones sao
expandidos em painéis. Simplesmente clique no botao fechar, e os painéis sao
removidos do espaco de trabalho.

Para restaurar os painéis flutuantes apds fecha-los, abra o menu Window e
selecione 0 nome de um dos painéis do grupo que foi fechado. Este painel
abre, junto de todos os outros painéis (ou icones) agrupados a ele. Muitos pai-

Fechar

:—l-l Figura 1-9. O botdo fechar esta
localizado na posigcao de cada

Windows Mac sistema operacional.

11
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Figura 1-10. Clique no par de setas para alternar entre icones e painéis.

néis possuem teclas de atalho para abrir e fechar. Utilizar um destes atalhos
também restaura um grupo flutuante fechado. Os atalhos de teclado estdo
listados no menu Window.

Alternando entre painéis e icones

Uma coluna de painéis pode ser totalmente expandida ou fechada em icones
clicando-se no pequeno par de setas no topo direito da coluna (veja a Figura
1-10). O Dreamweaver memoriza a largura tanto da coluna expandida quanto
dos icones, entdo, fechar os icones, os mostra com rétulos ou minimizados,
dependendo de sua escolha anterior.

Ocultando temporariamente os painéis

Quando vocé quer limpar a poluigao na tela para ver seu trabalho em toda
a gloria, simplesmente pressione F4. A maioria dos painéis ird desaparecer,
deixando apenas a Janela do Documento dominando sua tela. Vocé ainda tera
acesso a Barra de Ferramentas do Documento, Seletor de Tag e Barra de Sta-
tus, visto que sao partes integrais da Janela do Documento. A Barra do Aplica-
tivo também permanece visivel no topo da tela, assim como o painel Insert se
vocé o tiver convertido em uma barra Insert (veja “Utilizando e configurando o
painel Insert” mais tarde neste capitulo).

No Windows, a Janela do Documento se expande para preencher todo o es-
paco de trabalho. No Mac, a Janela do Documento nao muda de tamanho.
Entretanto, se vocé arrastar a alca de redimensionamento na parte inferior
direita da Janela do Documento, vocé pode fazé-la preencher toda a tela. Os
painéis retornam quando vocé pressiona F4 novamente, e tanto no Windows
guanto no Mac, a Janela do Documento encolhe para caber dentro da area de
trabalho. Na préxima vez em que vocé pressionar F4 no Mac, o Dreamweaver
ira lembrar-se de preencher a tela com a Janela do Documento.

Utilizando o Auto-Show

Pressionar F4 para restaurar todos os painéis pode ser um pouco cansativo
se Vocé quiser passar a maior parte do seu tempo na Janela do Documento,
entao o Dreamweaver CS4 adicionou uma nova fungao que automaticamente
mostra os painéis escondidos quando vocé move seu cursor de mouse para
a margem da tela. Se vocé mover seu mouse para a margem direita da tela,
qualquer painel escondido naquele lado automaticamente surge. Vocé entao
pode trabalhar nos painéis e eles automaticamente vao embora tao logo vocé
volte para a Janela do Documento. Este € o comportamento padrao.

Se vocé quiser que os painéis permanegam escondidos, cligue com o botao
direito em qualquer painel e escolha Auto-Show Hidden Panels. Como muitas
opcdes em menus contextuais, uma marca de verificacao ao lado do item in-
dica que a opgdo esta ativa; nenhuma marca de verificagdo indica que esta
desabilitada. Clicar na opg¢ao ativa-a e desativa-a.
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Pressionar F4 para esconder os painéis e utilizar o Auto-Show é uma forma muito
conveniente de trabalho. Confere-lhe bastante espaco para trabalhar em seu docu-
mento, mas coloca os painéis rapidamente a sua disposi¢cao. Entretanto, pode ser
dificil controlar se vocé oculta automaticamente a Barra de Tarefas do Windows ou
a Dock do Mac. Mover seu ponteiro de mouse muito longe na tela aciona a Barra de
Tarefas ou a Dock, ao invés dos painéis do Dreamweaver.

Ocultando a Barra do Aplicativo (Apenas no Mac)

Na versao do Windows do Dreamweaver CS4, a Barra do Aplicativo (veja a
Figura 1-3) contém todos os menus do Dreamweaver, ndo podendo assim, ser
desativada.

Na versao do Mac, os menus principais do Dreamweaver continuam parte da
interface do OS X, e a Barra do Aplicativo contém apenas um pequeno nimero
de menus de atalhos para opgdes que podem ser acessadas também através
dos menus principais. Caso a Barra do Aplicativo fique no seu caminho no
Mac, vocé pode escondé-la selecionando Windows » Application Bar. Selecio-
ne a mesma opcao N0 mMenu para restaura-la.

Movendo e reagrupando painéis

Os leiautes de espago de trabalho padroes organizam os painéis em grupos
I6gicos. Por exemplo, os painéis CSS Styles e AP Elements sao agrupados jun-
tos, pois ambos lidam com regras de estilos. Mas estes grupos sao apenas
sugestoes; vocé pode reorganizar os painéis da forma que quiser.

Movendo um tnico painel

Para mover um Unico painel, clique na aba dele e arraste para longe de sua po-
sicao atual em dire¢ao a Janela do Documento. Quando vocé libera seu botao
de mouse, o painel flutua independentemente. Vocé pode mover o painel para
onde quiser clicando na barra cinza-escuro no topo do painel e arrastando-o
para a nova posicao. Vocé também pode reduzir o painel ao modo iconico (com
ou sem r6tulo), encaixa-lo em um local diferente, agrupa-lo com um ou mais
painéis ou fecha-lo.

Movendo um painel para um grupo diferente

Para alterar o agrupamento de painel, cligue na aba do painel que deseja
mover e puxe-o para longe de sua posi¢ao atual. Enquanto vocé arrasta-o, ele
torna-se semitransparente. Arraste-o sobre o painel ou grupo de painéis alvo
até que uma borda azul surja ao redor do alvo, como mostrado na Figura 1-11,
e libere o botao do mouse. Apesar da figura mostrar o alvo como um Udnico
painel flutuante, o alvo também pode ser um grupo existente; nao importa se
ele estiver flutuando ou conectado dentro de uma coluna de painéis.

Alterando a ordem dos painéis dentro de um grupo

Se vocé preferir mostrar os painéis em uma ordem diferente, simplesmente
arraste uma das abas para a esquerda ou direita. Repita o processo até que
as abas estejam na ordem que vocé quiser.

13
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Figura 1—11. E facil reagrupar painéis.

Movendo um grupo de painéis

Mover um grupo de painéis é bastante simples, mas vocé precisa tomar cuida-
do com onde clicar para arrastar o grupo como um todo. Clique em qualquer
lugar entre a Gltima aba a direita e 0 menu do grupo de abas, como mostrado
na Figura 1-12. Em alguns grupos, isto deixa pouco espago onde posicionar o
cursor. Uma forma simples de lidar com este problema € tornar a coluna de
painéis mais larga arrastando sua lateral aberta. Isto amplia a area clicavel.
Uma vez reorganizados os painéis da forma como vocé quer, arraste-os nova-
mente para a largura desejada.

Clique nesta area para
arrastar o grupo

(S5 STYLES G INSPE( -E Menu do grupo de abas

Figura 1-12. Selecionar o local correto para arrastar um grupo de painéis pode ser compli-
cado algumas vezes.

Empilhando e encaixando painéis

Além de agrupar os painéis, vocé pode empilha-los para formar uma nova colu-
na, ou encaixa-los @ margem da tela ou outro grupo de painéis. A medida que
vocé arrastar um painel ou grupo de painéis, observe a grossa linha azul que
surge. Isto indica um alvo onde ela pode ser encaixada.

Utilizando e configurando o painel Insert

Como mencionei anteriormente, por padrao, o painel Inserte ocupa um grande
espaco devido aos rétulos préximos aos icones. O painel Insert também € in-
comum por agrupar muitos painéis em um.

Como o nome sugere a funcdo do painel Insert é inserir elementos utilizados
com frequéncia, como imagens, tabelas, tags <div>, elementos de formulario
e widgets Spry em uma péagina web. Eles ndo cabem convenientemente em
um Unico painel, entdo, estado divididos em categorias, que podem ser aces-
sadas através do menu logo abaixo da aba, como mostrado na Figura 1-13.
O Dreamweaver é sensivel ao contexto, entdo o menu pode mostrar, algumas

14
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Figura 1-13. O painel Insert con-
tém diversas categorias acessiveis
a partir do menu interno.

vezes, mais categorias do que é mostrado na figura (por exemplo, a categoria
PHP é acessivel em uma péagina PHP). A Tabela 1-3 descreve rapidamente o
gue contém cada categoria. Para beneficio dos leitores atualizando a partir do
Dreamweaver CS3, eu indiquei as principais mudangas.

Tabela 1-3. As principais caracteristicas das categorias do painel Insert

Categoria

Descricao

Mudancas do Dreamweaver CS3

Common

Layout

Forms

Data

InContext
Editing

Text

Favorites

Insere os objetos mais comumente utilizados, como
tabelas, imagens e tags <div>.

Oferece varias ferramentas para leiaute, inclusive
modificacoes em tabelas, frames e widgets Spry,
como a barra de menu (veja o Capitulo 6), e os
painéis com abas fechaveis (veja o Capitulo 7).

Cria formularios e insere todos os elementos de
formularios, incluindo widgets de validagao Spry
(validacao e formularios Spry sao cobertos no
Capitulo 9).

Oferece acesso a maioria das funcoes dinamicas,
incluindo conjuntos de dados Spry (veja o Capitulo
19) e comportamentos de servidores PHP (veja do
Capitulo 14 em diante). Também importa dados de
arquivos com valores separados por virgula (CSV

- comma-separated value) em uma pagina web
estatica.

Oferece ferramentas para o servi¢o online
hospedado pela Adobe que permite que usuarios
autorizados atualizem paginas web através de um
navegador comum (veja o Capitulo 13).

Fornece uma alternativa ao Property inspector para
opcoes comuns de formatacdo. Também é lar das
listas de defini¢ao e entidades HTML.

Fornece uma categoria em branco para vocé
personalizar (veja “Personalizando a categoria
Favorites” mais tarde nesta sec¢ao).

Foi adicionado Horizontal Rule.
Flash Buttom e Flash Text foram
removidos do submenu Media.

Sem mudancas.

Checkbox Group e trés novas
widgets de validagao Spry
(Password, Confirm e Radio Group)
foram adicionadas.

Spry XML Data Set e Spry Table
foram removidos e combinados
com a melhora da fungao Spry Data
Set (veja o Capitulo 19).

Nova categoria.

Sem mudancas.
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Figura 1-14. Muitos icones no painel Insert escondem submenus.

— Muitos icones no painel Insert possuem uma pequena seta aponta-
= da para baixo a direita, como mostrado ao lado. Isto indica que ele
contém um submenu com opcdes relacionadas. Na primeira vez em
gue vocé clica em um destes icones, o Dreamweaver mostra um submenu
apresentando todas as opcoes (a Figura 1-14 mostra as opgoes quando vocé
clica no icone Images). O Dreamweaver memoriza sua sele¢do e sempre mos-
tra as opcoes utilizadas mais recentemente. Se vocé quer utilizar a mesma
opgao novamente, clique no préprio icone. Para selecionar uma opcao diferen-
te, clique na seta a direita para revelar novamente o menu.

Para muitos usuarios do Dreamweaver, o painel Insert € uma das partes mais
utilizadas da Ul. Se vocé estiver feliz em trabalhar apenas com os icones, vocé
pode esconder os rotulos. Vocé também pode converter o painel em uma barra
de ferramentas com abas como a barra Insert das versoes anteriores do Drea-
mweaver. Independente do leiaute que vocé escolher, vocé pode popular a ca-
tegoria Favorites com sua propria selegao de itens utilizados frequentemente.

Escondendo os rotulos

Se vocé quer economizar espaco escondendo os rétulos ao lado de cada icone,
selecione Hide Labels na parte de baixo do menu do painel Insert (mostrado
no lado direito da Figura 1-13). Se vocé esquecer o que um icone representa,
simplesmente flutue o ponteiro do mouse sobre ele para visualizar a dica.

Esconder os rétulos deixa a vocé uma vasta expansao de painel ndo utilizado.
Para reduzir a altura do painel, clique na parte inferior e arraste-a para cima,
como mostrado na Figura 1-15.

Se vocé fizer isto com a categoria Common selecionada, podera notar que o
Dreamweaver impede vocé de puxar a parte de baixo do painel até que ela
figue exatamente abaixo da Ultima fileira de icones. Isto € porque as outras
categorias tém mais icones, entao espaco suficiente € deixado para mostrar a
maior categoria sem a necessidade de redimensionar o painel.
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Figura 1-15. Esconder os rotulos do painel Insert economiza muito espago.

Apesar disto economizar espaco, vocé ainda precisa ativar o menu para trocar
de categoria. Converter o painel em uma barra de ferramentas com abas evita
este problema.

Convertendo o painel Insert em uma barra de
ferramentas com abas

A forma mais simples de converter o painel Insert em uma barra de ferramen-
tas como a barra Insert das versoes anteriores é selecionar Classic no Seletor
de Espaco de Trabalho. Isto move o painel de sua localizagao atual para o
topo da tela e converte-o em uma barra de ferramentas com abas. Cada aba
representa uma categoria do menu do painel, conferindo-lhe acesso rapido e
pratico a todas as suas ferramentas. Se as abas nao estiverem visiveis, ative o
menu a esquerda da barra Insert e selecione Show as Tabs.

No Windows, a barra Insert é localizada abaixo da Barra do Aplicativo e se
estica por toda a largura da tela, como mostrado na Figura 1-16.

B fie fon Viea Dnsen Mot fomst Commnds fte Window Hop BN O A CLASSIC *

| common | (ageut | Faomi Gt | Gpe | et L Byugatar L

Yo AT T EH-H 800 4 BB P

Figura 1-16. A (nica posicao para a barra Insert no Windows € diretamente abaixo da
Barra do Aplicativo.

Usuérios de Mac tém duas opgoes. O leiaute padrao Classic de espaco de
trabalho na versao para Mac do Dreamweaver conecta a barra Insert no final
da Barra do Aplicativo, como mostrado na imagem superior da Figura 1-17. A
versao para Mac da Barra de Aplicativo contém apenas alguns itens, entao
converter o painel Insert em uma barra de ferramentas faz um melhor uso
do espaco na tela. Como dito anteriormente, se vocé nao quiser a Barra do
Aplicativo, vocé pode desativa-la na versao do Mac selecionando Window »
Application Bar. Isto move a barra Insert para a esquerda para ocupar o espaco

#®  Dreamweaver File Edit View Insert Modify Format  Commands Site Window Help e T 4 Thuldds Q.

Commzn | Layeat | Form | Dama| Spre | inContext Edning | Teay Favorses |
W G- A~ i « |[F = = e =
s e i BaEDAeE BEE- @ BFRHL-2-|B-F

#  Dreamweaver File Edit View Insent Modify Format  Commands  Site  Window  Help = 4 Thuldd? Q
Carmmon _hayawt. | Fanme | Oama . Spry Tewt _Favornes
WA BEEE-4- B0 S B-T

Figura 1-17. Na versao para Mac, a barra Insert pode ser mostrada com ou sem a Barra
do Aplicativo.
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tomado anteriormente pela Barra do Aplicativo, como mostrado na imagem
inferior da Figura 1-17. Entretanto, isto nao oferece nenhum beneficio real,
ja que toda a largura da tela ainda é reservada para a barra Insert com abas.
Diferente da versao do Windows, no Mac o fundo da barra Insert nao se expan-
de para preencher o espaco a direita. Ao contrario do que vocé possa esperar
vocé nao pode encaixar outros painéis a direita da barra Insert. Entretanto, se
vocé quiser ocupar este espaco vazio, pode flutuar outros painéis sobre ele.

Se vocé ja tiver reorganizado seu leiaute de espaco de trabalho e ndo quer
utilizar a pré-definicdo Classic, vocé pode destacar o painel Insert do seu local
atual arrastando sua aba em direcao ao topo da tela. Libere a aba quando
vocé observar uma grossa linha azul indicando onde ele sera encaixado. No
Windows, o Unico lugar onde vocé pode encaixar o painel Insert e mostrar a
interface com abas é diretamente abaixo da Barra do Aplicativo. No Mac, vocé
pode encaixa-lo a direita da Barra do Aplicativo, sob a Barra do Aplicativo, ou
caso a Barra do Aplicativo esteja escondida, no topo da tela.

O conveniente da barra Insert com abas €&, de certo modo, prejudicado pelo
fato dela ndo ser dimensionavel. Adicionalmente, vocé ndo pode encaixar nada
a direita dela, seja no Windows ou no Mac. Em meu monitor 1680 x 1050, os
icones da barra Insert nunca passam da metade da tela, entdo € muito es-
paco desperdicado. Aparentemente, isto se deve as limitagdes impostas pela
Ul compartilhada entre todos os programas do Creative Suite 4. Testando O
Dreamweaver CS4, descobri que a barra Insert com abas € mais eficiente, pois
eu posso utilizar o espaco em meu monitor. Infelizmente, se espaco for um
problema, desencaixar a barra Insert com abas nao resolve seus problemas.
Se vocé desconectar a barra Insert do topo da tela arrastando a dupla coluna
de ponto a sua esquerda, ela automaticamente se converte em um painel e as
abas ndo sdo mais acessiveis.

Alternando entre abas e menus

Se vocé preferir o menu para alternar entre as categorias, vocé pode utiliza-lo ao
invés da interface com abas da barra Insert. Clique com o botdo direito em qual-
quer lugar da faixa cinza-escuro a direita da Ultima aba e escolha Show as Menu.
Isto economiza alguns pixels de espaco vertical. Para mostrar novamente a inter-
face com abas, abra o menu a esquerda da barra Insert e escolha Show as Tabs.

Personalizando a categoria Favorites

Se alternar entre as categorias se tornar muito demorado, vocé pode popular a
categoria Favorites com seus itens utilizados com mais frequéncia. Esta opcao
esta disponivel independentemente de como

Customize Favorite Objects

&=d)  vocé configurou o painel Insert.

Available abjects:

Text

Abbreviation

- Acronym
Line Break (Shift + Enter)
Mon-Breaking Space

-Left Quots
Right Quote

EnDash
-Pound
Euro

2]

Favorit objects: 1] wl(al [ Clique com o botao direito em qualquer lugar
o Tee |G ) da éarea cinza-claro do painel ou barra Insert
ETFM =3 e selecione Customize Favorites a partir do
J|exterea menu contextual. O menu na parte superior

Button

————— esquerda da caixa de didlogo Customize Fa-
vorites Objects (mostrada na Figura 1-18) per-
[ Add separator | mite que vocé escolha a partir de uma lista
mestre ou categorias individuais. No painel
esquerdo, selecione um item por vez e clique

Figura 1-18. Personalize a categoria Favorites da barra ou pai-

no botdo com suas setas para adiciona-lo ao

nel Insert para acesso rapido as opcoes utilizadas com mais Painel Favorite objects a direita. Para remover

frequéncia.
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Figura 1-19. O Property inspector da acesso aos atributos principais da tag <img> quando uma imagem é selecio-

nada.

no botao com a lixeira na parte superior direita. As setas para cima e para
baixo préximas a lixeira podem ser utilizadas para alterar a posi¢cao do item
selecionado. O botdo Add separator abaixo da lista insere um separador apos
o item atual.

A caixa de didlogo Customize Favorite Objects da acesso a todas as cate-
gorias, incluindo aquelas sensiveis ao contexto, como PHP. O Dreamweaver
armazena os detalhes de sua categoria Favorites em sua pasta pessoal de
configuragoes, entdo, diferentes usuarios no mesmo computador podem ter
selecdes personalizadas (desde que utilizem contas diferentes). Vocé pode
copiar sua categoria Favorites para outro computador, como descrito na se-
¢ao “Migrando snippets e outras configuracdes pessoais” mais tarde neste
capitulo.

Utilizando o Property inspector

O Property inspector € o painel largo na parte inferior de diversos leiautes pré-
definidos de espacgo de trabalho, incluindo o padrao Designer (veja a figura
1-3). A aba diz, na verdade, Properties, entao muitas pessoas se referem a ele
como o painel Properties, mas o nome oficial € Property inspector e sera assim
que nos referiremos a ele neste livro.

O Property inspector é sensivel ao contexto; ele mostra propriedades relacio-
nadas a selegao atual na Janela do Documento. A Figura 1-19 mostra o con-
teddo do Property inspector quando uma imagem é selecionada. Como vocé
pode ver, ele da acesso aos atributos principais da tag <img>, incluindo src,
alt, widht, height e class. E também contém um pequeno nimero de ferramen-
tas de edi¢ao de imagem.
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Figura 1-20. Quando se edita texto, o Property inspector separa as opgoes para HTML e CSS.

Selecionando a visualizacao HTML e CSS no Property
inspector

Quando o cursor esta sobre uma parte vazia da Janela do Documento ou texto
é selecionado, o Property inspector mostra um conjunto completamente dife-
rente de opgoes. A Figura 1-20 mostra como ele fica quando uma citagdo a
esquerda da Janela do Documento é selecionada. O importante a se notar é
que ha dois botbes a esquerda do Property inspector: HTML e CSS. Estes sao
novos no Dreamweaver CS4, e vocé precisa checar cuidadosamente qual esta
selecionada, ja que as opgoes parecem bastante similares, mas funcionam de
formas bem diferentes.

Com o botao HTML selecionado, vocé pode formatar o texto aplicando tags
HTML (Hypertext Markup Language) como paragrafos (<p>) e titulos (<h1> até
<h6>), negrito (<strong>), italico (<em>) e listas com marcadores ou nimeros
(<ul> e <ol>), bem como aplicar hiperlinks (<a>). Se vocé estiver atualizando
de uma versao anterior do Dreamweaver, selecionar o botao HTML no Property
inspector Ihe da a maioria das opgdes que vocé estava acostumado a ver.
Entretanto, as op¢Oes para selecionar a fonte, tamanho e cor estao ausentes.
Para acessa-las, vocé precisa selecionar o botao CSS.

Padrdes web modernos advogam pela separagao do contelido e da apresen-
tacdo marcando a estrutura da pagina com HTML, enquanto deixam todos
os elementos estilisticos, como fontes, cores e fundos, para o CSS. Acompa-
nhando esta aproximacao, o Dreamweaver CS4 moveu as ferramentas para
estilizagao do texto e outros elementos a uma visualizagao separada do Pro-
perty inspector. A Figura 1-21 mostra a aparéncia do Property inspector quan-
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Figura 1-21. Selecionar o botao CSS no Property inspector revela opcoes para criagao
de regras de estilo para o elemento atual.

do vocé seleciona o botao CSS com a mesma citagao selecionada na Figura
1-20. Como vocé pode ver, ele possui um menu a esquerda chamado Targeted
Rule. Isto automaticamente seleciona a regra que o Dreamweaver julga mais
apropriada para editar, mas vocé pode fazer sua propria selecdo ou utiliza-lo
para criar uma nova regra. A utilizacdo da funcdo CSS do Property inspector é
coberta no Capitulo 4.

“Onde foi parar meu campo Link?” Este foi um dos mais comuns pedidos de ajuda
durante o beta publico do Dreamweaver CS4. Usuarios regulares do Dreamweaver
estdo acostumados a sempre verem o campo Link no mesmo lugar do Property ins-
pector e entram em panico quando ele ndo esta la. Ele ainda esta onde sempre
esteve, mas esta visivel apenas quando o botdo HTML esta selecionado. O Dreamwe-
aver sempre memoriza sua selecdo mais recente, entao se vocé esteve trabalhando
com CSS, precisa retornar para acessar as op¢oes de formatacdo HTML, incluindo
a criacao de hiperlinks.

Configurando o Property inspector

O Property inspector nao é tao versatil quanto o painel Insert quando se fala em
rearranjar seu espaco de trabalho. Vocé pode cortar sua altura pela metade cli-
cando no pequeno triangulo virado para cima na parte inferior direita do Property
inspector (veja a Figura 1-21). Entretanto, isto oculta todas as op¢oes da metade
inferior. Nao ha muitas opcdes para texto na metade inferior (veja as Figuras 1-20
e 1-21), mas como mostra a Figura 1-19, ha muito mais para imagens. Para res-
taurar o Property inspector a sua altura completa, clique no tridngulo novamente
(ele esta apontado para baixo quando a metade inferior esta oculta).

Infelizmente, os trés icones na margem direita do Property inspector tém o
costume irritante de desaparecer em monitores menores que 1280 x 1024
pixels (a especificacdo minima para o Dreamweaver CS4 é 1024 x 768). Os
icones sdo escondidos atras de qualquer painel a direita do Property inspector.
Este € um problema conhecido que torna a reducéo do Property inspector um
negoécio arriscado e ndo recomendado em monitores pequenos. Se vocé nao
puder acessar o triangulo de expansao, feche qualquer painel para o modo
iconico. Se isto nao funcionar, desencaixe o Property inspector da parte de
baixo da tela arrastando sua aba para dentro da Janela do Documento. Isto
deve mostrar o Property inspector com largura total, dando acesso ao tridangulo
de expansao.

Uma forma melhor de obter mais espaco na Janela do Documento é clicar
na barra cinza-escuro junto a aba do Property inspector. Isto reduz o painel
contendo o Property inspector a uma faixa estreita na parte inferior da tela.
Clique novamente, e o painel é restaurado ao seu tamanho normal. Vocé tam-
bém pode economizar espaco ocultando automaticamente todos os painéis
quando eles nao estao em uso pressionando F4, como descrito anteriormente
neste capitulo.
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Uma grande reclamacao sobre o Property inspector é que
ele se estica horizontalmente para ocupar o espaco disponi-
vel na parte inferior da tela, mas todos os campos de texto
continuam do mesmo tamanho. Em monitores grandes re-
sulta em muito espaco desperdicado. Vocé pode destacar o Property
inspector da parte de baixo da tela e utilizad-lo como um painel flutuan-
te. Uma vez flutuando, ele pode ser fechado no modo iconico com ou
sem o rétulo, como mostrado ao lado. Quando vocé expande o Proper-
ty inspector no modo iconico, ele ocupa 825 x 130 pixels e nao pode ser redi-
mensionado.

PROPERTIES

Destacar o Property inspector de sua posi¢ao padrdo pode ser uma experiéncia frus-
trante. Mesmo que vocé arraste-o por alguma distancia, ele teimosamente retorna
a parte inferior da tela. O segredo € fechar os outros painéis que estejam abertos e
entao arrastar o Property inspector para a metade superior da tela.

Utilizando o grupo de painéis Results

Por padrao, o grupo de painéis Results fica oculto em todos os leiautes de es-
pago de trabalho pré-definidos. Ele se abre automaticamente na parte inferior
da tela (abaixo do Property inspector caso ele ja esteja na parte inferior) apos
executar certas operacoes, como as de busca e substituicao, validagao ou
checagem de links. Ele também contém o painel Reference (Shift+F1), que
contém guias abrangentes sobre HTML, CSS e outras tecnologias web (infeliz-
mente, o material de PHP esta bastante defasado).

Para minimizar o grupo de painéis Results, pressione F7 ou clique na barra
cinza-escuro a direita das abas. Isto deixa as abas visiveis na parte inferior da
tela. Pressionar F7 ou clicar na barra cinza-escuro abre e fecha o painel. Para
se livrar completamente deste grupo de painéis, clique com o botao direito na
barra cinza-escuro e selecione Close Tab Group. Entretanto, ele reabre auto-
maticamente sempre que exigido pelo Dreamweaver. Vocé nao pode se livrar
dele permanentemente, nem deveria fazé-lo; ele contém informacgdes Uteis.

0 problema com o grupo painel Results é que ele ndo pode ser redimensionado
em sua localizacao padrao, normalmente dificultando a leitura do conteldo. A
melhor forma de utilizar o grupo painel Results é torna-lo um painel flutuante
arrastando a barra cinza-escuro a direita das abas em dire¢ao a Janela do Do-
cumento. Uma vez flutuando, vocé pode redimensiona-lo arrastando qualquer
um dos dois cantos ou qualquer lado, exceto o topo. Outro beneficio € que
pressionar F7 fecha o grupo de painéis completamente, ao invés de minimiza-
lo. Alternativamente, vocé pode converté-lo em um painel iconico.

Gerenciando espacos de trabalho

A capacidade de configurar seu espaco de trabalho de varias formas torna
o Dreamweaver CS4 extremamente versatil, mas e se vocé nao gostar das
mudangas? Ou se vocé gostar das mudancas, mas nao trabalhar sempre da
mesma forma? A Adobe resolveu estes casos incluindo opgdes para restaurar
0 espacgo de trabalho atual a sua configuragao original e salvar as personali-
zacoes.

Na parte de baixo do Seletor de Espaco de Trabalho (veja a Figura 1-4 anterior-
mente, neste capitulo) estdo estas trés opgoes:
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m Reset ‘Workspace’: isto restaura o espaco de trabalho atual as suas con-
figuracdes originais (Workspace € substituido pelo nome real). Funciona
tanto com leiautes pré-definidos que acompanham o Dreamweaver quan-
to com seus proprios leiautes personalizados.

m New Workspace: Isto abre uma caixa de didlogo que permite que vocé
salve seu préprio leiaute personalizado. Uma vez configurado o espaco de
trabalho ao seu gosto, simplesmente selecione esta opcao, dé um nome
ao seu novo espago de trabalho e clique OK. Isto adiciona o leiaute per-
sonalizado ao Seletor de Espaco de Trabalho, permitindo que vocé altere
para ele a qualquer momento.

m Manage Workspaces: Isto mostra uma lista dos leiautes personalizados
armazenados na pasta de configuragdo do usuario atual com opgoes para
renomea-los ou deleta-los. Uma vez deletado um leiaute, vocé ndo pode
restaura-lo.

0 Seletor de Espaco de Trabalho esta sempre visivel na versao para Windows
do Dreamweaver CS4. Se vocé tiver ocultado a Barra do Aplicativo no Mac
0S X, vocé pode acessar as opcoes do Seletor de Espaco de Trabalho a partir
do submenu Workspace Layout no menu Windows (as mesmas opcoes estao
disponiveis no Windows).

O Dreamweaver armazena os detalhes dos leiautes personalizados como arqui-
vos XML (Extensible Markup Language), um formato independente de platafor-
ma, entdo vocé pode compartilhar leiautes com outros usuarios, mesmo que eles
estejam utilizando sistemas operacionais diferentes. Para detalhes, veja a se¢ao
“Migrando snippets e outras configuracoes pessoais”, mais tarde neste capitulo.

Explorando a Janela do Documento

Seja vocé um designer, programador, ou um pouco de cada, a Janela de Docu-
mento é onde vocé faz a maior parte do seu trabalho no Dreamweaver. Como
a Ul, ele possui diversas novas fungoes. Algumas, como Arquivos Relacionados
e Visualizagao Live View, tém um impacto importante no fluxo de trabalho com
o Dreamweaver. Outros, como a visualizagao Vertical Split e Split Code, sao
simples melhorias que provavelmente serdo consideradas bem vindas a pro-
dutividade de novatos e veteranos.

A Figura 1-22 mostra as partes principais da Janela do Documento (na visuali-
zacao Design, mostrando um arquivo utilizado mais tarde no livro). As segoes
seguintes descrevem rapidamente as varias opgoes disponiveis na Janela do
Documento. Como elas sao utilizadas no contexto da constru¢ao de um websi-
te é coberto no resto do livro.

Trabalhando com janelas com abas

Por padrao, o Dreamweaver mostra as paginas web, arquivos JavaScript, folhas
de estilo e todos os outros documentos web em uma interface com abas. As
abas sao criadas da esquerda para a direita na mesma ordem em que as pagi-
nas foram abertas, mas vocé pode arrasta-las e solta-las em qualquer ordem.

Visualizando o caminho do arquivo

0 caminho fisico do arquivo do documento selecionado no momento é mostra-
do na barra cinza-escuro junto das abas. Infelizmente, se vocé tem um nlimero
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Figura 1-22. Uma pagina web mostrada na visualizagao Design.

grande de abas abertas, isto esconde o caminho do arquivo. Entretanto, vocé
sempre pode ver o caminho do arquivo flutuando o cursor do mouse sobre
a aba do documento, onde ele € mostrado como uma dica. A barra de ferra-
mentas Coding (descrita na sec¢ao “Utilizando a barra de ferramentas Coding”,
mais tarde neste capitulo) também mostra uma lista contendo o nome do ca-
minho completo de todos os arquivos abertos.

Fechando Abas

Para fechar um documento, clique no botao fechar no lado direito da aba. Isto
é diferente das versoes anteriores do Dreamweaver e provavelmente confunde
usuarios do Windows, que terao de lidar com o habito de ir ao topo direito da Ja-
nela do Documento para fechar um documento (onde vocé provavelmente acer-
tara o botao restaurar por engano). Apesar de diferente das versoes anteriores,
isto aproxima o Dreamweaver da forma como funcionam os navegadores, entao
a mudanca é bastante légica. Usuarios do Mac podem se sentir um pouco des-
confortaveis pelo botdo fechar sem tem sido movido do lado esquerdo da aba
para o lado direito, estando agora no lado oposto ao do navegador Safari.

Para fechar todas as abas de uma vez, clique com o botao direito em qual-
quer aba e selecione Close All a partir do menu contextual. Alternativamente,
utilize File » Close All no sistema principal de menus ou o atalho de teclado
Ctrl+Shift+W/Shift+Cmd+W.

Para fechar todos os documentos exceto a aba selecionada, clique com o bo-
tao direito sobre a aba e escolha Close Other Files a partir do menu contextual.
O menu contextual da aba oferece outras op¢oes para abrir, salvar e comparar
documentos (a compara¢ao de documentos depende da configuracao de um
utilitario externo; veja o Capitulo 2 para detalhes).
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Visualizando documento fora da interface com abas

Se vocé decidir que ndo quer seus documentos visualizados na interface com
abas, vocé pode separa-las. 0 método depende de seu sistema operacional.

No Windows, clique no botao restaurar no topo direito da Janela do Documento
para visualizar o documento no que parece ser uma janela normal. Ela possui
botbes para minimizar, maximizar e fechar como qualquer outra janela, mas
seus movimentos estao restritos ao interior da Janela do Documento. Se vocé
abrir um novo documento, ele abre uma janela similar. Clicar no botao maximi-
zar faz com que a janela retorne as abas do Dreamweaver.

A versao para Mac funciona de forma consideravelmente diferente. Por pa-
drao, o primeiro documento abre em uma janela comum. A interface com
abas sb surge quando vocé abre dois ou mais documentos. Se vocé preferir
abrir o primeiro documento também em uma aba, selecione Dreamweaver
> Preferences (Cmd+U), escolha a categoria General, e coloque uma marca
de verificacao na opcao Always show tabs. Se vocé nao quiser aba nenhuma,
certifique-se de que tanto a opgao Open documents in tabs quanto Always
show tabs estdo desselecionadas. Vocé também pode mover um documento
de sua aba para uma janela separada clicando com o botao direito na aba e
selecionando Move to New Window a partir do menu contextual.

Obtendo acesso rapido aos arquivos relacionados

0O Dreamweaver CS4 tem duas poderosas novas ferramentas que dao a vocé
acesso instantaneo as folhas de estilo, arquivos JavaScript externos e outros
documentos conectados a uma pagina web. A fungao Arquivos Relacionados
suporta todos os arquivos conectados, onde o Code Navigator é dedicado ao
trabalho com folhas de estilo.

Utilizando a barra de ferramentas Arquivos
Relacionados

Se vocé trabalha regularmente com folhas de estilos externas, arquivos JavaS-
cript, ou inclusos do lado do servidor, esteja preparado para uma das maiores
melhorias em seu fluxo de trabalho. A fungao Arquivos Relacionados detecta
automaticamente se o documento atual tem conexdes com arquivos externos
e lista-os na barra de ferramentas Arquivos Relacionados logo acima da barra
de ferramentas do documento (veja a Figura 1-22). O Dreamweaver carrega o
codigo de cada arquivo na meméria, dando acesso instantédneo simplesmente
clicando no nome do arquivo na lista de Arquivos Relacionados. Isto significa
que vocé nao precisa mais procurar no painel Files para localizar uma folha
de estilos ou arquivo JavaScript para edicao; eles estao ali a um clique de
mouse.

A barra de ferramentas Arquivos Relacionados nao lista imagens, arquivos SWF
ou outros recursos visuais, para nao ficar poluida com arquivos irrelevantes.
Normalmente, o Dreamweaver s6 percorre um nivel de profundidade, entdo
apenas arquivos conectados diretamente a pagina sao listados. Por exemplo,
caso o0 documento principal utilize um incluso do lado do servidor chamado
menu.inc.php, ele é listado, mas qualquer arquivo incluso diretamente pelo
menu.inc.php ndo sera listado. Folhas de estilo € a (inica excec¢ao. Todas as fo-
Ihas de estilo que afetam o documento s&o listadas, nao importando a profun-
didade na hierarquia do site. Por exemplo, se styles.css utiliza @import para
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conectar em more_styles.css, ambos sao listados, mesmo que o documento
principal nao tenha conexao direta com more_styles.css.

Caso o documento principal tenha tantos arquivos relacionados que os nomes
nao caibam todos na barra de ferramentas Arquivos Relacionados, uma seta
dupla aparece no fim da lista. Clique nela para revelar uma lista de arquivos
restantes. Arquivos sao listados na ordem que estao conectados ao documen-
to principal. Vocé nao pode alterar a ordem na barra de ferramentas Arquivos
Relacionados. Arquivos adicionados a pagina ap6s ela ter sido aberta na Ja-
nela do Documento sdo adicionados automaticamente a barra de ferramentas
Arquivos Relacionados. Se um arquivo nao aparecer na barra de ferramentas,
pressione F5. Este é o atalho de teclado para atualizar a visualizagdo Design,
gue também tem efeito na atualizacdo da barra de ferramentas Arquivos Re-
lacionados.

Quando vocé clica em um nome de arquivo na barra de ferramentas Arquivos
Relacionados, o Dreamweaver abre a visualizagao Split, mostrando o cédigo do
arquivo relacionado em metade da Janela do Documento, enquanto mantém o
documento principal na visualizagao Design na outra metade, como mostrado
na Figura 1-21 (veja a secao “Alternando entre as visualizagdes Code, Design
e Split” mais tarde neste capitulo, para detalhes sobre como mudar o leiau-
te). O arquivo relacionado é editavel e vocé pode ver o resultado da mudanca
imediatamente pressionando F5 ou clicando na metade da Janela do Docu-
mento que corresponde a visualizagao Design. Nao ha necessidade de salvar
o0 arquivo relacionado primeiro, entdo se vocé nao gostar do resultado, pode
continuar editando o arquivo até obter o resultado desejado. O Dreamweaver
coloca um asterisco (*) junto do nome do arquivo que vocé editou indicando
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Figura 1-23. A fungao Arquivos Relacionados permite que vocé edite folhas de estilos na visualizagdo Code e veja os
resultados instantaneamente na visualizagao Design.
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que as alteracoes nao foram salvas. Para salvar as alteracoes, certifique-se de
que o foco esta na visualizagcdo Code e pressione Ctrl+S/Cmd+S ou selecione
File » Save. Para rejeitar as alteracoes, cliqgue em No quando perguntado se
deseja salvar quando fechar o documento principal.

Quanto estiver atualizando para o Dreamweaver CS4, vocé pode achar a fungao Ar-
quivos Relacionados desorientadora a principio, ja que ndao ha mais necessidade
de se abrir as folhas de estilos e arquivos JavaScript externos em abas separadas.
Se vocé abrir um arquivo relacionado em sua prépria aba, o Dreamweaver mantém
ambas as versoées sincronizadas uma com a outra, mas registrar onde vocé estava
trabalhando pode ser confuso. Se vocé achar que a fun¢ao Arquivos Relacionados
nao se enquadra no seu fluxo de trabalho, vocé pode desabilita-la selecionando Edit
» Preferences (Dreamweaver > Preferences no Mac), escolhendo a categoria Gene-
ral, e desselecionando Enable Related Files. Vocé precisa reiniciar o Dreamweaver
para a alteracgao ter efeito. A funcao Arquivos Relacionados nao pode ser ativada ou

desativada rapidamente.

Utilizando o Code Navigator para editar folhas de estilo

Se a pagina atual tiver regras de estilos, seja em uma folha de estilos
#*=| externa ou no <head> do documento, deixe seu cursor na Janela do

Documento por alguns segundos sem qualquer atividade e um peque-
no icone como o timao de um navio (como mostrado ao lado) surge. Nao im-
porta se vocé esta na visualizagdo Code ou Design; ele continua aparecendo.
Se vocé ndo sabe o que ele &, provavelmente ele lhe deixara maluco em pouco
tempo. Mesmo que vocé saiba o que €, a persisténcia dele pode ser simples-
mente enlouquecedora.

0 icone foi colocado ali para ser descoberto (se ele ndo aparecer, ndo se preo-
cupe, pois eu irei recomendar a vocé desabilita-lo e utilizar o atalho de teclado e
mouse no lugar). A idéia é fazer vocé descobrir as maravilhas do Code Navigator.

A Figura 1-24 mostra o que aconteceu quando coloquei meu cursor dentro da
citacdo a esquerda da imagem, esperei o icone surgir e entdo cliquei nele. O
Code Navigator mostrou uma lista de regras de estilo afetando a citagao, mos-
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trando detalhes de cada uma em uma janela pop-up a medida em que flutuo
0 mouse sobre o nome da regra. Caso isto ainda nao seja impressionante o
suficiente, cada regra de estilo € um hiperlink. Simplesmente clique e o Drea-
mweaver abre a folha de estilos como um arquivo relacionado na visualizagao
Split, com seu cursor dentro da regra selecionada para edi¢ao.

Se a sua pagina web é criada a partir de um modelo do Dreamweaver ou con-
tém um item da biblioteca, o Code Navigator também providencia um link para
o modelo mestre ou arquivo da biblioteca (modelos sdo cobertos no Capitulo
13; itens da biblioteca nao sao cobertos neste livro, pois inclusos PHP - co-
bertos no Capitulo 12 - sdo mais eficientes). De modo similar, se a pagina
contiver um <iframe>, o Code Navigator fornece um link para o documento
fonte. Quando vocé clica em um destes links, o arquivo abre em uma nova aba,
pronto para edigao.

Uma vez descoberto o Code Navigator, eu recomendo que vocé se livre do
irritante icone surgindo o tempo todo. Simplesmente coloque uma marca de
verificagao na opgao Disable indicator na parte inferior direita do Code Naviga-
tor (veja a Figura 1-24). Ap6s desabilitar o icone, vocé pode visualizar o Code
Navigador segurando a tecla Alt (Opt+Cmd em um Mac) enquanto clica em
qualquer lugar da Janela do Documento.

Apesar de poder redimensionar o Code Navigator, vocé ndao pode mové-lo para
uma posicao diferente. Se vocé achar que ele esta bloqueando sua visao da
pagina, tenha em mente que onde vocé clica enquanto segura a tecla Alt ou
Opt+Cmd nao muda a selecao atual ou posi¢ao do cursor na visualizacao De-
sign. Isto simplesmente determina a localizagao do canto superior esquerdo
do Code Navigator (se nao houver espaco suficiente, ele vai para a posicao
mais préxima).

Se vocé preferir utilizar um atalho de teclado para invocar o Code Navigator,
é Ctrl+Alt+N no Windows a Opt+Cmd+N no Mac. O Code Navigator também é
acessivel através do menu View, 0 menu contextual em qualquer visualizagao
e na Barra de Ferramentas Coding (veja a Figura 1-31, mais tarde neste ca-
pitulo). Ha tantas formas de acessar o Code Navigator, que algo me diz que a
Adobe nao queria que VOCé nao o visse.

Para fechar o Code Navigator, simplesmente clique em qualquer outro lugar
da tela.

Explorando a Barra de Ferramenta do Documento

Correndo no topo da Janela do Documento esta a Barra de Ferramentas do
Documento, que diz respeito, basicamente, com controlar a aparéncia do am-
biente de trabalho (veja a Figura 1-25). Os primeiros trés botdes a esquerda

Gerenciamento Auxilios
Live Code de Arquivo Atualizar Visuais

v v

| 42| Code || Desian | | [ #]Live View |v [: Title: | Stroll Along the Thames . &, 'E‘ (&, ™ [ checkPage
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Figura 1-25. A Barra de Ferramentas do Documento controla a aparéncia da Janela do Documento
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permitem que vocé alterne rapidamente entre a visualizagao Code, Design e
uma combinacao de ambas chamada visualizacao Split, como mostrado ante-
riormente na Figura 1-23. O préximo botao, rotulado Live View, ativa e desativa
outra inovagao importante do Dreamweaver CS4, que renderiza a pagina como
ela ira ficar em um navegador concordante com os padroes sem a necessida-
de de sair da visualizacao Design.

A secao seguinte descreve brevemente cada uma destas funcoes.

Alternando entre as visualizacoes Code, Design e Split

Alguns web designers, particularmente aqueles com um passado de desig-
ner grafico, nunca querem ver o cédigo HTML, CSS ou JavaScript que existe
atras da visualizacdo Design. Esta € a receita do desastre no Dreamweaver.
Apesar do design visual de seu ambiente, vocé ndo pode trata-lo como um
processador de texto ou programa de editoragdo grafica. Vocé precisa ter um
bom entendimento de onde esta inserindo elementos em uma péagina - algo
gue é particularmente importante quando vocé mistura elementos dindmicos
utilizando uma tecnologia do lado do servidor como PHP ou widgets JavaScript.
Vocé nao precisa conhecer cada tag e propriedade, mas vocé precisa ter uma
boa compreensao das tecnologias que existem por tras da criagdo de uma pa-
gina web adequada aos padroes. O Dreamweaver ajuda vocé tornando facil a
alternancia rapida entre a visualizagdo Code a visualizagdo Design, bem como
mostrar ambas na visualizacao Split.

Os ro6tulos nos trés botdes a esquerda da Barra do Documento sdo bastante
autoexplicativos.

Code: esta mostra o c6digo cru. Quando o documento € uma pagina web esta-
tica, ela da acesso ao cédigo da forma como vocé pode vé-lo na visualizagdo
fonte do navegador. Caso a pagina utilize uma tecnologia do lado do servidor,
como PHP, ele mostra o cédigo do lado do servidor antes de ele ter sido pro-
cessado. As paginas que contém apenas cédigo, como arquivos JavaScript ou
folhas de estilos, sao sempre mostradas na visualizagao Code.

Split: esta mostra a visualizagcao Code em metade da tela e a visualizagao
Design na outra metade.

Design: este é o ambiente visual do Dreamweaver para criacdo e edicdo de
paginas web. Ela mostra uma aproximacgao bastante precisa de como a pagina
ird ficar em um navegador.

A configuragdo padrao para a visualizagdo Split € dividir a pagina horizontal-
mente com a visualizagao Code no topo, como mostrado anteriormente na
Figura 1-23. Vocé pode inverter o leiaute mostrando a visualizagao Design no
topo e a visualizagdo Code na parte inferior. Melhor ainda, agora vocé pode di-
vidir a tela verticalmente, como mostrada na Figura 1-26. Este leiaute funciona
melhor em um monitor largo (a tela foi capturada no espaco de trabalho Clas-
sic com o Dreamweaver maximizado em um monitor 1680 x 1050 com todos
0s painéis ocultados). O padrdao é mostrar a visualizagao Design a direita, mas
vocé pode inverter isto.

A visualizacao Split vertical foi solicitada ha muito tempo por usuarios regu-
lares do Dreamweaver. Qutra das suas solicitacdes também foi respondida:
a visualizacao Split Code, que permite a vocé visualizar se¢oes diferentes do
codigo do mesmo documento. A visualizagado Split Code pode ser mostrada di-
vidida tanto na vertical quanto na horizontal. Cada secao de tela rola de forma
independente. Vocé pode recortar e colar de uma secdo para outra, mas nao
pode arrastar e soltar.
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Figura 1-26. Em um monitor grande, a visualizagao Split vertical torna facil ver simultaneamente as visualizagoes
Code e Design.

0 acesso a todas estas opcdes da visualizacdo Split se da através do menu
View ou do controle Layout na Barra do Aplicativo, como mostrado na Figura
1-27. A nado ser que vocé tenha ocultado a Barra do Aplicativo na versao do
Mac, utilizar o controle Layout é mais simples, pois ha menos opgdes para es-
colher. Se as opgodes Split Vertically e Design View on Left estiverem apagadas,
altere para a visualizacao Split selecionando Code and Design. (Quando a tela
esta dividida horizontalmente, a op¢ao Design View on Left muda para Design
View on Top.)

Se vocé tiver mais de um documento aberto, as opgdes de visualizagao Split
sao especificas para cada aba. Para configurar seu leiaute de visualizagdo
Split como um padrao, feche todos os documentos exceto um. Configura suas
opcoes desejadas e entao feche o documento. O Dreamweaver memoriza suas
preferéncias e aplica-as a todos os documentos futuros, mas vocé pode alter-
nar para um leiaute diferente a qualquer momento.

DY Fie Edit View

¢ Common Cade

EE =] - &- i) - | B Split Cade

Design

Insert Modify Format Commands  Site Window Help |@ Dy S

+ Code and Design

42| Code ﬂﬁ' 5| Design ] [ | #| Live View |vI[ [<3] live Cc-deJ Title: |Stroll Along the Thamed ¥
< I sel—[if B>

Figura 1-27. Vocé pode utilizar o controle Layout na Barra do Aplicativo para mudar para a visualizagdo Split verti-
cal.
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Figura 1-28. Utilizar o Live view torna possivel a visualizagao dos efeitos das mudancas das regras de estilo para
fungdes dinamicas.

Utilizando o Live view para testar paginas

Outra alteracdo importante no Dreamweaver CS4 é a introducdo do Live view.
Ele utiliza a engine de cédigo aberto WebKit browser (HTTP://webkit.org/) para
mostrar o documento atual exatamente como ele ird parecer em um nave-
gar adequado aos padroes. O Dreamweaver utiliza, essencialmente, a mes-
ma versao do WebKit do Safari 3, mas com certas alteracoes para fornecer
funcionalidades extras a visualizacdo Design. Caracteristicas dindmicas, como
rollovers, menus JavaScript, e cédigos do lado do servidor, funcionam como
espera-se em um navegador. Apesar disto ndo substituir um teste da pagina
em todos os navegadores, utilizado em combinacdo com a funcdo Arquivos
Relacionados, torna a edicdo de caracteristicas dinamicas, uma moleza. As
Figuras 1-28 e 1-29 mostram o Live view em acao.

O Live view faz uma incrivel diferenga quando se trabalha com Ajax ou Spry
(implementacdo Adobe do Ajax). A imagem na Figura 1-28 mostra como vocé
pode testar um efeito rollover em uma barra de menu Spry (veja o Capitulo 6)
sem a necessidade de deixar a Janela do Documento. Eu acionei o Live view,
ative a barra do menu na visualizagcao Design, invoquei o Code Navigator e
entao selecione a regra de estilo: hover para itens do menu. Isto abriu a folha
de estilos como um arquivo relacionado na visualizagao Split, pronta para eu
editar. Apds alterar a propriedade de cor, pressione F5 para atualizar a visuali-
zacao Design e passei 0 mouse sobre a barra do menu para ver os resultados
da mudanca. Eu nao gostei do resultado, entao cliquei No quando perguntado
sobre salvar as alteragoes ao fechar o documento.

Ajax significa Asynchronous JavaScript and XML (veja http://en.wikipedia.org/wiki/
AJAX). Originalmente, Ajax significa a utilizar JavaScript para se comunicar com o
servidor web e redesenhar partes da pagina sem a necessidade de recarregar toda
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Buckingham Palace and St James's Park

St James's Park is my favourite among all the parks in central London. It lies on a
gentle slope between The Mall and Birdcage Walk, and is home to many water birds,
. . including a pair of pelicans. What makes St James's so pleasant is its mix of trees,
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a pagina. Desde entdo, seu significado foi ampliado para abranger quase qualquer
técnica que utilize uma das bibliotecas JavaScript populares como Prototype (http://
www.prototypejs.org), script.aculo.us (http://script.aculo.us/), e jQuery (http:;//
jquery.com/). Spry € a biblioteca JavaScript da Adobe que faz funcionar a barra de
menu Spry (Capitulo 6), varios efeitos e widgets (Capitulo 7, 8 e 9), e conjuntos de
dados Spry (Capitulo 19).

A imagem superior da Figura 1-29 mostra como uma galeria de imagens cons-
truida com um conjunto de dados Spry fica na visualizacdo Design. No Dreamwe-
aver CS3, vocé precisava carregar a pagina em um navegador externo toda vez
em que quisesse ver a pagina finalizada. O Live view torna isto coisa do passado
(os dados devem vir de uma fonte estatica; conjuntos de dados Spry que utilizam
dados gerados dinamicamente ainda precisam ser visualizados em um navega-
dor). A imagem inferior da Figura 1-29 mostra a mesma pagina com o Live view
acionado. Nao apenas vocé pode ver a pagina como ficara em um navegador,
como a imagem principal muda quando vocé clica em uma das miniaturas.
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O Live view também funciona com paginas do lado do servidor, como em PHP,
tao logo vocé tiver definido um servidor de teste na definicao do site (veja o Ca-
pitulo 2). Se vocé estiver atualizando de uma versao anterior do Dreamweaver,
isto substitui efetivamente a visualizacao Live Data (a préoxima secao explica
a diferenga). Mesmo que vocé nao tenha um servidor teste, o Live view ainda
mostra as partes em HTML estéatico da pagina.

A seta apontada para baixo a direita do botdo Live View abre um menu que
controla as seguintes opcoes:

m Freeze JavaScript: esta opcao do menu é basicamente um lembrete do
atalho de teclado (F6) para congelar efeitos dindmicos controlados pelo
JavaScript. Por exemplo, rollovers que dependam da posi¢gao do mouse. Se
vocé pressionar F6, os rollovers permanecem congelados mesmo quando
vocé afasta seu mouse para trabalhar em um arquivo relacionado.

m Disable JavaScript: esta opcao permite que vocé veja como a pagina fica-
rd em um navegador que ndo suporte JavaScript ou onde os JavaScripts
estejam desabilitados.

m Disable Plugins: isto desabilita os plugins, como o Flash Player, para que
vocé possa ver o efeito em um navegador que nao tenha o plugin.

m Use Testing Server For Document Souce: isto se aplica apenas as paginas
que utilizem tecnologia do lado do servidor, como PHP. E necessério con-
figurar um servidor teste na defini¢ao do site (veja o Capitulo 2) para que
o cédigo do lado do servidor possa ser processado. Quando vocé clica no
botdo Live View em uma pagina PHP, o Dreamweaver automaticamente
pergunta a vocé se quer atualizar a pagina no servidor teste. Vocé deve
clicar Yes para que o codigo dindmico seja processado. Se vocé clicar No,
ele pergunta se vocé quer utilizar, no lugar, os arquivos da fonte local.
Utilizar os arquivos da fonte local faz com que apenas os elementos HTML
estaticos sejam mostrados.

m Use Local Files For Document Links: Isto ndo significa que vocé possa
utilizar os hiperlinks no Live view para navegar para outras paginas do
seu site. Isto refere-se a utilizacao das versoes locais das folhas de estilos
e arquivos externos JavaScrip, ao invés de utilizar aqueles que estdo no
servidor teste.

m http Request Settings: Isto abre uma caixa de didlogo que permite que
vocé configure variaveis POST e GET para serem passadas a pagina quan-
do mostrada no Live view.

Com a excecgao de HTTP Request Settings, todas as opcoes de menu Live view
sao ativadas e desativadas clicando-se nelas. Uma marca de verificagao ao
lado da opcao indica que ela foi ativada.

0 que aconteceu com o Live Data e como difere-se o
Live view?

Caso vocé tenha atualizado a partir de uma versao anterior do Dreamweaver,
pode ficar confusa a diferenc¢a entre o Live view e a visualiza¢ao Live Data.

Nas versdes anteriores, o Live Data facilitava a visualizacdo da saida de pa-
ginas utilizando c6digo do lado do servidor, como PHP e Active Server Pages
(ASP), processando o codigo através de um servidor teste e mostrando-a na
visualizagdo Design. A Live view, por outro lado, funciona com todas as paginas
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web, ndo apenas aquelas com tecnologia do lado do servidor; e utiliza uma
engine real de navegador para mostrar o conteldo de sua pagina. Vocé ainda
precisa de um servidor teste para mostrar a saida dindmica do cédigo do lado
do servidor, mas o Live view reproduz a pagina mais precisamente que o Live
Data. Para a maioria dos propésitos, Live view substitui a visualizagao Live
Data.

Apesar do Live view ser muito mais preciso, um revés potencial é o fato de vocé
nao poder editar diretamente na visualizacdo Design quando o Live view esta
acionado. Vocé deve desativar o Live view ou editar o codigo fonte na secdo de
visualizacdo Code na visualizagdo Split. Entretanto, hA momento em que pode
ser (til editar os elementos HTML de uma pagina ao mesmo tempo em que se
visualiza a saida do cédigo do lado do servidor. Por exemplo, vocé pode querer
editar as células de cabegalho estaticas de uma tabela gerada dinamicamen-
te. Por esta razao, a visualizagao Live Data foi mantida no Dreamweaver CS4.
Entretanto, ela ndo é mais acessivel na Barra de Ferramentas do Documento.
Para ativar a Live Data, utilize a opgao do menu View > Live Data ou o atalho de
teclado Ctrl+Shift+R/Shift+Cmd+R (a op¢do do menu € visivel apenas quando
o documento atual € uma pagina dinamica).

Apenas HTML estatico pode ser editado na visualizagdo Live Data. Saida gerada
pelo codigo do lado do servidor ndo pode ser alterada exceto editando-se o codigo
fundamental diretamente na visualizacdo Code.

Inspecionando codigo gerado dinamicamente com o
Live Code

0 ressurgimento do interesse em JavaScript surgindo da popularidade do Ajax
e de bibliotecas como o jQuery e o Spry indubitavelmente trouxeram benefi-
cios. O JavaScript vé uma pagina web em termos de uma estrutura hierarquica
conhecida como Modelo Objeto Documento (Document Object Model [DOM]),
gue pode ser manipulada para produzir efeitos dinamicos, incluindo rollovers e
painéis deslizantes, e para reorganizar o contelido da pagina. A dificuldade, do
ponto de vista do desenvolvedor é que o JavaScript manipula a DOM nos bas-
tidores dentro do navegador, entdo pode ser muito dificil resolver caso alguma
coisa dé errado. Se vocé pudesse ver o codigo HTML gerado pelo JavaScript...
bem, agora vocé pode, gracas ao botdo Live Code na Barra de Ferramentas do
Documento.

A funcao Live Code permite que vocé inspecione o HTML gerado nao somente
pelo JavaScript, mas também por linguagens do lado do servidor como PHP
(tdo logo defina um servidor teste). Ele se baseia no Live view, entdo o botao
Live Code se mantém apagado na Barra de Ferramentas do Documento até
que o Live view seja invocado. Quando vocé clica no botao Live Code, o Dre-
amweaver abre a visualizacao Split (caso ainda nao esteja aberta) e mostra
o codigo gerado na visualizagao Split. Como um lembrete visual de que vocé
esta visualizando o cédigo gerado no lugar do original, a cor de fundo da vi-
sualizacao Split muda para amarelo. A Figura 1-30 mostra parte do script da
galeria de imagens Spry da Figura 1-29 como vista na visualizacao Code nor-
malmente (imagem superior) e com o Live Code acionado (imagem inferior).
Os comandos JavaScript destacados em cinza na imagem superior sao inter-
pretados pela engine do Live Code para gerar duas tags <option> com valores
extraidos de um conjunto de dados Spry.
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Figura 1-30. O Live Code permite que vocé veja o HTML gerado pelo JavaScript e linguagens do lado do servidor.

Caso vocé ache dificil de aturar o fundo amarelo claro do Live Code, precisara mer-
gulhar nas entranhas de seu computador para muda-lo.

No Windows, vocé precisa modificar o Registro do Windows. Isto néo é dificil, mas
pode afetar o funcionamento do seu computador caso vocé nao seja cuidadoso. No
Windows Vista, clique no botao Iniciar e digite regedit no campo de busca. Isto deve
mostrar o regedit.exe no topo da lista de resultador. Clique nele para abrir o Editor de
Registro. No Windows XP, abra o Editor de Registro clicando Inicia > Executar, digi-
tando regedit na caixa de dialogo Executar e clicando OK. No Editor de Registro, se-
lecione esta entrada no painel esquerdo: HKEY_CURRENT_USER\Software \Adobe\
Dreamweaver CS4\Tag Colors. No painel direito, selecione Background Color - Live
Code, clique com o botéo direito e escolha Modify no menu contextual. Digite uma
nova cor em notacdo hexadecimal (e.g., #FFC para um amarelo mais claro) no cam-
po Value Data e clique OK. Feche o Editor de Registro e reinicie o Dreamweaver.

Em um Mac, abra Macintosh HD:Users><username>:Library:Preferences:Adobe
Dreamweaver 10 Prefs em um editor de texto como o BBEdit ou TextWrangler (am-
bos de http://www.barebones.com). Localize esta linha: background color - live
code=#FF7. Mude o #FF7 para uma nova cor em notacdo hexadecimal. Entao salve
0 arquivo e reinicie o Dreamweaver.

O Live Code é uma adicao Util ao arsenal de ferramentas de debugging do de-
senvolvedor. Entretanto, nao o confunda com um debugger de verdade como o
plugin FireBug para o navegador Firefox (http://www.joehewitt.com/software/
firebug/). Ele ndo Ihe informara sobre erros de sintaxe em seu codigo. Mas
mostrando exatamente o que esta sendo fornecido pelo JavaScript ou codigo
do lado do servidor, o Live Code fornece confirmacao (ou o contrario) de que
seu script esteja fazendo o esperado. O Live Code mostra contelido gerado,
entdo vocé ndo pode editar a visualizagdo Code quando ele esta acionado.

Outras opcoes na Barra de Ferramentas do Documento

A lista seguinte descreve rapidamente as outras opgoes na Barra de Ferramen-
tas do Documento:

m Titulo: & onde vocé digita o titulo do documento que é mostrado na barra
de titulo do navegador.

m Gerenciamento de Arquivo: oferece uma forma rapida de fazer o upload e
download do arquivo atual para e do servidor remoto. A configuragao da
conexao é coberta em detalhes no Capitulo 2.

m Pré-visualizagao no Navegador: mostra a pagina atual em um navegador
externo ou no Device Central. O Dreamweaver automaticamente detecta
0s navegadores instalados em seu computador e lista-os em um menu. O
Device Central € um emulador que permite que vocé veja como ficara sua
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pagina web em um dispositivo mével. E um programa separado instalado
automaticamente com o Dreamweaver, a nao ser que vocé o desselecione
durante o processo de instalacao.

m Atualizar: atualiza a visualizacdo Design. E utilizado apenas quando vocé
esta trabalhando com o c6digo base na visualizagao Split. De outro modo,
a visualizagao Design se atualiza automaticamente. Vocé também pode
utilizar F5.

m Opcoes de Visualizacao: ativa e desativas as réguas e guias na visualiza-
cao Design. Também controla a funcao Code view, como numeracao de
linhas e a quebra automatica de linha.

m Auxilios visuais: controla os auxilios visuais CSS descritos no Capitulo 4.

m Validacao: verifica seu documento, arquivos selecionados, ou todo o site
com base nos padroes W3C (World Wide Web Consortium). Entretanto,
nao funciona em paginas PHP e o validador do Dreamweaver perde alguns
erros, particularmente quando verifica contra uma Definicao de Tipo de
Documento restrita (DTD - Document Type Definition). Faga uma segun-
da verificacao com o Servico de Validacao de Marcacao W3C oficial em
http://validator.w3.org.

m Check page: verifica a pagina atual em relagdo a compatibilidade com na-
vegadores e acessibilidade. O resultado € mostrado no grupo de painéis
Results. Ele verifica apenas codigo estatico, entdo pode ndo produzir re-
sultados significativos em paginas que geram o contelido dinamicamente
com Spry ou PHP. A verificagao de compatibilidade com navegador forne-
ce links para explicacoes mais detalhadas e solucdes sugeridas no web-
site da Adobe. Vocé também pode acessar o website CSS Advisor (http://
www.adobe.com/go/bccdw) diretamente a partir do menu Check page.

Extraindo o melhor da visualizacao Code

A visualizacdo Code ndo é apenas para inspecionar o cédigo base. E um gran-
de ambiente de edicdo com muitas fungdes, como dicas de cddigo, colora-
cao de sintaxe e complementacao automatica do codigo, desenvolvidas para
tornar a programacao um prazer e ndo um esforgo. De fato, alguns usuarios
regulares do Dreamweaver confessam passar 100 por cento do tempo deles
aqui. Independentemente de vocé ser um programador ou um designer € (Gtil
conhecer seu caminho pela visualizagao Code.

Duas novas funcoes que serao de interesse particular aos leitores vindos das
versoes anteriores do Dreamweaver sao a introspecgao de codigo para JavaS-
cript e a possibilidade de imprimir o c6digo em cores.

Utilizando a Barra de Ferramentas Coding

A Barra de Ferramentas Coding € mostrada no lado esquerdo da visualizagao
por padrao. Também esta disponivel no Code Inspector (F10/0pt+F10), que
permite que vocé visualize o codigo base de uma pagina em uma janela sepa-
rada. A Barra de Ferramentas Coding nao pode ser desconectada, mas vocé
pode oculta-la na visualizagao Code desselecionando-a no menu View > Tool-
bars (ou a partir do menu contextual em qualquer barra de ferramentas). No
Code Inspector, € controlada de forma independente pelo menu View Options
no topo do inspetor.
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Nao confunda o Code Inspector com o Code Navigator, que € novo no Dreamweaver
CS4 e foi descrito anteriormente neste capitulo. O Code Navigator é dedicado ao
trabalho com CSS, onde o Code Inspector mostra o c6digo base do documento atual
em um painel separado. E normalmente utilizado apenas em leiautes de espaco de
trabalho com dois monitores, efetivamente permitindo que vocé veja a visualizacao
Code e a visualizagdo Design em tela cheia em um monitor separado. Para abrir o
Code Inspector, pressione F10/0pt+F10 ou selecione Windows » Code Inspector.

A Figura 1-31 mostra a fun¢ao de cada botao na Barra de Ferramentas Coding;
a mesma informacao é mostrada como uma dica se vocé deixar o cursor do
seu mouse sobre um destes botoes. Se nao houver espaco suficiente para
mostrar todos os botdes, uma seta dupla aparece apds o Gltimo botdo que pu-
der ser visto no espaco disponivel. Clique nela para visualizar o resto da barra
de ferramentas junto da visualizacao Code.

Dois botoes foram adicionados desde o Dreamweaver CS3: Mostrar Code Na-
vigator e Alertas de Erros de Sintaxe. Adicionalmente, o icone para Mover ou
Converter CSS foi alterado para se adequar ao painel CSS Styles no modo
icbnico.

Vamos dar uma olhada rapida no que faz cada botéo.

m Documentos Abertos: mostra uma lista dos documentos atualmente aber-
tos junto do caminho completo de cada arquivo. Isto € muito Gtil se vocé
tem diversas paginas abertas, todas com 0 mesmo nome (como index.php
de diferentes pastas ou sites). Clique no nome de um arquivo e ele vem
para frente - sem precisar adivinhar se o arquivo correto esta aberto.

m Mostrar o Code Navigator: mostra o Code Navigator, que foi descrito ante-
riormente neste capitulo. As regras de estilo mostradas no Code Navigator
dependem da localizagao atual do seu cursor. A capacidade de identifi-
car a regra de estilo correta parece menos precisa na visualizacao Code.
Quando se trabalha na visualizagdo Split, € recomendavel selecionar ele-
mentos na metade da visualizagao Design da Janela do Documento antes
de clicar neste botao.

™ Documentos Abertos

% Mostrar o Code Navigator

++ FecharToda aTag

++| Fechar Selecao

% ExpandirTudo
Selecionar Tag Pai

# Equilibrar Colchetes
Numeracao das Linhas
Destacar Cadigo Invalido
Alertas de Erros de Sintaxe
Aplicar Tags de Comentarios
Remover Tags de Comentarios
Embalar Tag

Snippets Recentes

Mover ou Converter CSS
Recuar Codigo

Avancar Cédigo

Formatar Codigo Fonte

6

~
g

R0 B

F

Figura 1-31. A Barra de Ferra-
mentas Coding
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m Fechar Toda a Tag: Seleciona o bloco de cédigo no qual esta localizado

atualmente o seu cursor e fecha tudo dentro, incluindo a abertura e fecha-
mento de tags. Infelizmente, ndo pode ser utilizado para selecionar um
bloco de cédigo PHP. Para fechar tudo fora de uma tag completa, segure
a tecla Alt/Opt enquanto clica no botao Fechar Toda a Tag. Isto € Gtil para
isolar um bloco de cédigo e esconder o resto da pagina.

m Fechar Selecao: Isto fecha o cddigo selecionado atualmente. Para fechar

todo o cédigo fora da selecao, segure a tecla Alt/Opt enquanto clica no
botdo Fechar Selec¢ao.

m Expandir Tudo: clique para expandir todas as se¢oes fechadas

Selecionar Tag Pai: seleciona a tag pai da selecao atual ou onde quer que

0 ponto de insercao esteja localizado atualmente. Por exemplo, se o0 seu
cursor esta dentro de um paragrafo, ele seleciona todo o paragrafo e as
tags <p> circundantes. Clicar novamente sobe na hierarquia do documen-
to, sempre selecionando o elemento pai da selecao atual.

Equilibrar Colchetes: seleciona todo o c6digo entre o par de colchetes,
chaves ou parénteses. Este botdo ajudara vocé a manter a sanidade ao
trabalhar com JavaScript e cédigo PHP.

Numeracao das Linhas: ativa e desativa a visualizagdo do nimero das
linhas na visualizacao Code.

Destacar Cédigo Invalido: O Dreamweaver destaca em amarelo as tags
aninhadas de forma incorreta. Isto pode ser distrativo na visualizacao
Code, particularmente quando se trabalhar com PHP, onde estruturas
condicionais podem resultar em codigos que o Dreamweaver interprete
incorretamente como invalidos. Este botdo ativa e desativa o destaque
amarelo na visualizacdo Code. O padrao é desativado.

Alertas de Erros de Sintaxe: faz surgir uma barra amarela no topo da vi-
sualizacao Code sempre que o Dreamweaver descobre o que pensa ser
um erro de sintaxe no JavaScript. Como vocé pode ver na Figura 1-32, o
Dreamweaver trata qualquer declaragao incompleta como um erro. Ele
nao remove o aviso até que vocé digite o fechamento do bloco de fungao.
Se vocé digjta seu préprio JavaScript, descobrird que o alerta constan-
te é extremamente irritante. Desative os alertas clicando neste botédo e
utilize-o apenas para verificar seu script quando terminado. Clicar neste
botdo ativa e desativa a funcdo e o Dreamweaver memoriza sua Gltima
selegao.

Aplicar Tags de Comentarios: permite a vocé aplicar tipos diferentes de
tags de comentarios na linha ou secao atual. Comentarios PHP sao cober-
tos no Capitulo 10.

Remover Tags de Comentarios: remove tags de comentarios da linha ou
selecao atual.

Untitled-2* x |

[ﬂ Code ] [ ][ Title:

/B There is a syntax error on line 3. Code hinting may not work until you fix this error.

0o

Figura 1-32. O verificador
de sintaxe de JavaScript

B runction tende a ser super zeloso

quando se trata de erros.
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Tabela 1-4. Atalhos de teclado para fechar cédigo

Acao Atalho do Windows Atalho do Mac
Fechar toda a tag Ctrl+Shift+) Shift+Cmd+)J
Fechar fora da tag Ctrl+Alt+) Opt+Cmd+)J
Fechar selecao Ctrl+Shift+C Shift+Cmd+C
Fechar fora da selegcao Ctrl+Alt+C Opt+Cmd+C
Expandir tudo Ctrl+Alt+E Opt+Cmd+E

m Embalar Tag: fornece uma forma rapida de embalar a selecdo atual em
uma tag HTML. O Dreamweaver permite que vocé selecione qualquer tag,
mesmo uma inapropriada para o contexto atual. Isto é baseado no prin-
cipio de que, se vocé esta trabalhando na visualizacao Code, deve saber
0 que esta fazendo. Quando misturado com a l6gica condicional do PHP,
codigos aparentemente invalidos normalmente estdo corretos, entdo o
Dreamweaver nao tenta intervir.

m Snippets Recentes: mostra uma lista dos itens do painel Snippets utili-
zados recentemente, fornecendo acesso rapido aos snippets de codigo
utilizados com mais frequéncia.

m Mover ou Converter CSS: fornece uma forma rapida de nove regras de
estilo, como descrito no Capitulo 4.

m Recuar Codigo: move a tag de abertura da selecao atual para a direita. Se
nao houver nada selecionado, o Dreamweaver seleciona automaticamen-
te a tag pai e move-a. A tecla Tab executa a mesma fungao.

m Avancar Codigo: move a tag aberta para a esquerda. Vocé também pode
utilizar Shift+Tab.

m Formatar Codigo Fonte: revela um menu que permite que vocé aplique for-
matacado padrado a toda pagina ou a seleg¢ao atual. Também fornece aces-
so rapido a categoria Code Format do painel Preferences e o Tag Library
Editor. O Tag Library Editor da a vocé controle sobre como cada tag HTML
é formatado em seu cédigo base. E de interesse de usudrios avancados,
mas a interface é intuitiva e simples de utilizar.

m Além de utilizar a Barra de Ferramentas Coding para fechar secdes do
codigo, vocé pode utilizar os atalhos de teclado listados na Tabela 1-4.
Quando vocé fecha uma secao do cédigo, ele afeta apenas o que vocé vé
na visualizacdo Code; os contelidos continuam totalmente expandidos na
visualizagdo Design. O Dreamweaver memoriza quais se¢oes do cédigo
foram fechadas quando a pagina € salva, entao o mesmo leiaute € visivel
na visualizagcdao Code na proxima vez em que vocé abre o documento.

Para inspecionar uma secao fechada, destaque-a e utilize o botdo com um
sinal de adicao na margem esquerda (€ um tridngulo na versao do Mac) para
expandi-la ou flutue o cursor do mouse sobre ela para visualizar o contelido
como uma dica.

Para selecionar secdes do codigo na visualizagdo Code, utilize os botbes Sele-
cionar Tag Pai ou Equilibrar Colchetes. Alternativamente, utilize seu mouse ou
teclado na mesma maneira que faria em um editor de texto. Clique duplo sele-
ciona a palavra atual. Clique triplo seleciona a tag pai. (Os atalhos de selegao
do GolLive nao funcionam no Dreamweaver.)
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B [ Check Page
Word Wrap
Line Mumbers
Hidden Characters
Highlight Invalid Code
Syntax Coloring
Auto Indent

Syntax Error Alerts in Info Bar

ColerIcons

Configurando as opcoes da visualizacao Code

A visualizacdo Code possui uma série de opgdes que vocé pode con-
figurar acessando View > Code View Option ou a partir do menu Op-
¢oes de Visualizagao na Barra de Ferramentas do Documento (veja a
Figura 1-25 e a imagem ao lado). Vocé aciona e desativa as opcoes
clicando nelas. Um marca de verificagao ao lado da opgao indica que
ela esta ativa. Estas opgdes funcionam como segue:

m Word Wrap: a forma como o Dreamweaver quebra o texto na visu-

alizacao Code confunde muita gente. Ha duas opgdes: soft e hard

wraping. O soft wraping esta ativo por padrao e funciona como um

processador de texto. Quando um codigo normalmente se estende-

ria além da borda direita da visualizacao Code, o Dreamweaver au-
tomaticamente quebra-o para a préxima linha. Se vocé redimensionar a
visualizagao Code, o cédigo reorganiza-se automaticamente para caber
na visualizagdo. Nenhum caractere de nova linha é inserido no cédigo até
que vocé pressione Enter/Return. Se vocé preferir seu c6digo em uma Uni-
ca linha e nao se importar em rolar horizontalmente, desselecione Word
Wrap. O hard wraping esta desativado por padrao. Quando acionado, ele
automaticamente insere um caractere de nova linha em uma disténcia
pré-definida da margem esquerda. Apesar disto fazer o cédigo parecer or-
ganizado, causa problemas sérios com JavaScript e ndo € recomendado.
Ele é controlado pela op¢ao Automatic wraping na categoria Code Format
no painel Preferences (Edit > Preferences ou Dreamweaver > Preferen-
ces). Se vocé tiver ativado esta opcao, eu recomendo desativa-la e utilizar
o0 soft wraping em seu lugar.

Line Numbers: o Dreamweaver mostra o nimero das linhas na margem
esquerda da visualizacao Code. Eles sao gerados automaticamente e nao
se tornam parte de seu codigo. Os nimeros das linhas sado particular-
mente (teis para localizar problemas com codigo PHP. Vocé também pode
ativa-los e desativa-los a partir da Barra de Ferramentas Coding. Linhas
que sdo quebradas com soft-wrapped possuem apenas um nidmero de
linha, mesmo que abranja diversas linhas nas telas.

Hidden Characters: esta opgao revela caracteres que nao sao normalmen-
te visiveis em seu codigo. Normalmente deve estar desativada, mas po-
dem ser Uteis para resolver problemas causados por caracteres de nova
linha indesejados em PHP ou JavaScript.

Highlight Invalid Code: esta opcao do menu faz o mesmo que o botao Des-
tacar Cédigo Invélido na barra de ferramentas descrita na se¢éo anterior.

Syntax Coloring: o Dreamweaver destaca HTML, PHP e outros cédigos em
cores pré-definidas de acordo com a fungao que ele exerce, tornando facil
identificar se¢des chaves do cédigo rapidamente. Esquecer de fechar um
par de aspas resulta no codigo subsequente sendo mostrado na cor erra-
da, alertando-o do erro. Em circunstancias normais, esta opgao deve estar
sempre ativa. Vocé pode ajustar as cores de acordo com sua preferéncia
indo a Edit > Preferences (Dreamweaver > Preferences em um Mac) e
selecionando Code Coloring. Escolha o tipo apropriado de documento (Do-
cument type) e clique em Edit Coloring Scheme.

Auto Indent: com esta opgao selecionada, o Dreamweaver automatica-
mente recua seu codigo de acordo com as configuracdes na categoria
Code Format no painel Preferences e no Tag Library Editor.
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m Syntax Erros Alerts in Info Bar: esta opcao faz o mesmo que o botao Aler-
tas de Erros de Sintaxe da Barra de Ferramentas Coding descrito na se¢ao
anterior.

m Design View on Left: esta opgdo estd disponivel apenas na visualizagdo
Split vertical; na visualizagao Split padrao, ela muda para Design View on
Top. Em ambos os casos, controla em que lado da visualizagcao Split apa-
rece a visualizacao Design.

m Color Icons: alterna os icones entre tons de cinza e coloridos.

Utilizando dicas de codigo e auto completar

Por padrao, o Dreamweaver mostra dicas de c6digo contextuais <body>
na visualizagdo Code. Por exemplo, se vocé digitar um sinal de | ™ <
“menor que” apds uma tag <body> de uma pagina HTML, um | & iﬁiibm -

menu contextual surge, mostrando todas as tags HTML validas, g B

#

como mostrado na imagem ao lado. Vocé pode rolar para baixo ¢ applet
para encontrar a tag que quer e dar duplo clique para inseri-la ou (=) 8 e

simplesmente continuar digitando. Tao logo vocé digite di, 0 menu <> base

contextual destaca <>div. Pressione Enter/Return e o Dreamwea- g

£ basefont
£ bdo i
ver completa o nome da tag.

Quando vocé pressiona a barra de espago, outro

menu contextual surge desta vez mostrando todos |, :’;idjd=
os atributos validos para a tag. Novamente, role para a5 Dyt v
baixo para selecionar o que quer ou continue digi- </html>
tando. Se vocé digitar id e pressione Enter/Return,
]

header
nav
thispage
wrapper

o Dreamweaver insere id="" e posiciona o ponto de
insercao entre as aspas, pronto para vocé inserir o
valor ID. Melhor ainda, se a sua pagina ja tiver uma
folha de estilos anexada a ela, o Dreamweaver popu-
la uma lista de IDs definidas, como mostrado na imagem ao lado. Utilize as
teclas de seta do teclado e Enter/Return para inserir sua op¢ao. Alternativa-
mente selecione-a com o cursor do mouse e dé duplo clique.

" Refresh Style List
| Attach Style Sheet...

Estes menus contextuais continuam a aparecer até que vocé digite o sinal de
“maior que” fechando a tag. Se vocé perder o menu contextual, simplesmente
pressione Ctrl+barra de espago em qualquer lugar entre os sinais de abertura
e fechamento de uma tag.

0 atalho de teclado para dicas de codigos na versdo Mac € o mesmo do Windows
(Ctrl+barra de espago) para evitar conflito com o Spotlight, que utiliza Cmd+barra
de espaco.

0 Dreamweaver € inteligente o suficiente para rastrear as tags que sao aber-
tas. Tao logo vocé digite </ na visualizagao Code, ele automaticamente insere
a tag de fechamento correta. Por exemplo, digamos que vocé tenha o seguinte
c6digo em uma pagina:

<p>Este texto é <strong>negrito e <em>italizado

Se vocé digitar </ trés vezes, o0 Dreamweaver automaticamente completa as
tags abertas na ordem correta assim:

<p>Este texto é <strong>negrito e <em>italizado</em></strong></p>
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JSON JavaScript.

A Unica excegdo a este auto-completar € a tag de fechamento com <script>. Isto é
para evitar que o Dreamweaver feche a tag <script> incorretamente dentro de um
bloco de JavaScript.

Para contabilidade com as versdes anteriores, vocé pode fazer com que o
Dreamweaver insira a tag de fechamento correspondente a medida em que
vocé digita o sinal de “maior que” de uma tag de abertura. Entao, se vocé
digitar <p>, o Dreamweaver insere </p> e coloca o ponto de inser¢cao entre
as tags de abertura e fechamento. Esta configuracdo pode ser Util quando se
trabalha com PHP pois o Dreamweaver as vezes confunde qual tag deve ser
completada caso haja codigo dindmico entre elas. Vocé também pode dizer
ao Dreamweaver para nunca completar as tags. Para alterar a configuracao
padrao, selecione Edit » Preferences (Dreamweaver » Preferences em um
Mac) e escolha a categoria Code Hints.

A maioria das pessoas acha as dicas de codigo valiosas, mas caso elas cha-
teiem vocé ou fiquem em seu caminho, vocé pode atrasar a aparicao delas
por até cinco segundos ou desativa-las totalmente. Entretanto, o Dreamwea-
ver responde muito mais rapido se vocé deixar o atraso em sua configuracao
padrao de zero. A opgao Menu na categoria Code Hints do painel Preferences
permite que vocé desative as dicas de codigo para categorias individuais. Por
exemplo, vocé pode decidir que quer dicas de codigos apenas para tags HTML
e propriedades CSS. Todas as categorias estao habilitadas por padrao.

Apresentando o suporte melhorado para dicas de
codigo JavaScript

As versoes anteriores do Dreamweaver ofereceram apenas suporte limitado a
dicas de codigo para JavaScript. Ndo somente as dicas de codigo estavam incom-
pletas, como também estavam disponiveis apenas em arquivos JavaScript exter-
nos. As dicas de codigo JavaScript agora também estdo disponiveis em blocos
<script> nas paginas web. Além disto, a amplitude de dicas de cdigo agora signi-
fica que programadores sérios de JavaScript podem continuar a trabalhar dentro
do Dreamweaver CS4 sem a necessidade de alternar para um outro programa.

O Dreamweaver agora tem dicas de codigos para propriedades e métodos dos
seguintes tipos de dados primitivos: Object, Array, Boolean, Number, RegExp e
String. Também tem suporte para o objeto DOM interno principal. As dicas de
c6digo sao ativada tao logo vocé digite um ponto apés uma variavel ou objeto.

A novidade mais bem vinda para todos os programadores é que o Dreamwea-
ver CS4 também é capaz de introspeccao de codigo. Isto significa que o Dre-
amweaver analisa suas proprias funcoes, classes e objetos JavaScript Object
Notation (JSON) e também fornece dicas de c6digo para eles. Suas definicdes
padrao podem ser tanto no mesmo documento quanto em um arquivo externo
(tao logo ele esteja conectado ao documento em que vocé esta trabalhando).
A Figura 1-33 mostra um exemplo de dica de c6digo sendo mostrada para uma
fungao personalizada definida no <head> de uma pagina web.

<script type="text/javascript">
function annoyingScript (message

alert('Hi, there! ' + message);
Figura 1-33. O Dreamweaver CS4 <"i=f;13:>
. P </head>
agora fornece dicas de codigo para
suas proprias funcoes, classes e <body onload="annoyingScript (">
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Imprimindo o codigo em cores

Isto é algo que foi solicitado por muitos anos: o Dreamweaver CS4 finalmente
imprime o cédigo em cores. Para imprimir o c6digo do documento atual, se-
lecione File » Print Code, clique com o botao direito na visualizagao Code e
selecione Print Code no menu contextual ou pressione Ctrl+P/Cmd+P.

O Dreamweaver utiliza as mesmas cores da visualizacao Code. Entretanto, ele
nao imprime a cor de fundo, mesmo que vocé a tenha alterado do padrao
branco; qualquer parte do cédigo que seja branca ou quase branca é converti-
da para preto. Para imprimir o c6digo em preto e branco, desselecione Syntax
Coloring em View » Code View Options ou no menu Opc¢oes de Visualizacao da
Barra de Ferramentas do Documento.

A numeracdo das linhas € incluida na impressdo. Para desativa-la, dessele-
cione Line Numbers em View » Code View Options ou no menu Opgoes de
Visualizagao na Barra de Ferramentas do Documento.

Utilizar o atalho de teclado Ctrl+P/Cmd+P imprime o cédigo base mesmo que vocé
invoque-o na visualizagdo Design. Ele nao imprime o leiaute da pagina. Para imprimir
a aparéncia da pagina, vocé precisa abrir a pagina web em um navegador e imprimi-
la de Ia.

Uma olhada rapida em outras mudancas do
Dreamweaver CS4

0 foco principal deste capitulo foi um passeio profundo da Ul tanto para nova-
tos quanto veteranos. Mas tanto mudou no Dreamweaver CS4, que também
foi um guia para as novidades. Entdao eu acho que compensa investir um pou-
co de tempo observando as novas caracteristicas restantes, a maioria delas
coberta em maiores detalhes nos capitulos seguintes. Também é importante
perceber que algumas funcdes foram removidas do Dreamweaver, entao tam-
bém cobriremos o que saiu.

Compartilhamento de tela

Normalmente é mais rapido e eficiente mostrar a um cliente ou colega como
fazer algo ao invés de tentar explicar o procedimento com palavras. Gragas
a nova funcdo chamada Creative Suites Extended Service (CSXS), vocé pode
fazer isto com o Dreamweaver e a maioria dos outros aplicativos CS4, mesmo
que a outra pessoa esteja do outro lado do mundo. De fato, vocé pode convidar
até trés outras pessoas para participarem da demonstracdo. Tudo que vocé
precisa € uma Adobe ID, que envolve o registro de alguns detalhes basicos no
site da Adobe (http://www.adobe.com). Caso vocé ainda nao tenha uma ID,
pode criar uma na primeira vez em que acessar o CSXS.

No momento do langamento inicial do Dreamweaver CS4, apenas dois servigos
estavam disponiveis: a fungdo Buscar por Ajuda (veja a Figura 1-3 e a Tabela
1-1) e Share My Screen, que fornece compartilhamento de area de trabalho
instantaneo através de uma conexao de internet. Atualmente nao ha custos
para o servigo de compartilhamento de tela, entao por que nao tentar?
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Por que o compartilhamento de tela é gratuito? Sem divida porque a Adobe espera
que a experiéncia de utilizar este tipo de conferéncia de area de trabalho encorajara

as
ou

empresas a se inscrever para a versao paga, que pode hospedar até 15, 500
1.500 participantes, dependendo do nivel da inscri¢ao (http://www.adobe.com/

products/acrobatconnect/).

Configurando uma sessao de compartilhamento de tela

As instrucoes seguintes guiam vocé através do processo basico de compar-
tilhar sua tela com até trés outras pessoas. O servico de compartilhamento
de tela é hospedado através do Adobe ConnectNow, entdo vocé precisa estar
conectado a Internet para usa-lo.

1.

Dentro do Dreamweaver CS4, selecione File » Share My Screen.

2. O Dreamweaver se comunica com o servidor ConnectNow e quando ele

estabelecer uma conexao, vocé deve ser o painel de login mostrado na
Figura 1-34.

Se vocé nao tiver uma Adobe ID, clique no link Create a free Adobe ID e
siga as instrugoes na tela.

Se vocé ja tiver uma Adobe ID, digite seu endereco de e-mail e a senha da
Adobe nos campos apropriados.

Se vocé selecionar a caixa de verificagao rotulada Remember me on this
computer, na préxima vez em que acessar File » Share My Screen, o pai-
nel de login ird desaparecer tdo logo o Dreamweaver tiver conectado-se ao
servidor Adobe.

Share My Screen ﬁ
Ey BE - Don't have an Adobe ID?
T, GONNEGINOW, S
‘Share Your,
. Sign in to share I screen.
Screen . i
Please sign in with your Adobe ID and Password.,
Meethve over the web and
<hare your screen with up to oW hadres (o Aviobe D)
3 people
= Forgot your Adobe ID?
Collaborate with remote £ - =
parbiapants using mtegrated Ptk
audio, chat, video and
whiteboards
Forgot your Password?
Personalize your meetings
with a unsque URL to share
with others || Remember me on this computer
]fﬂisk:u.ﬂtmm.l_a’,durﬂmﬂism
Learn More—
Adobe Connectow is part of
Acrobat.com
| Sgnia | Cewel |
Copyright 2008 Adobe Systems Incorporated. All Rights Reserved.

Figura 1-34. Para compartilhar sua tela com até trés outros, vocé precisa conectar-se ao Adobe ConnectNow.
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Welcome to Adobe Connecthlow!

Others can jain you in your room using this URL:

| hitps:/iconnectnow.acrobat. comidavidpowers

Figura 1-35. O Adobe ConnectNow
da a vocé uma URL personalizada
para suas sessoes de compartilha-
mento de tela.

Se esta for a primeira vez em que vocé estiver se conectando ou vocé
preferir ndo conectar-se automaticamente, clique no botdo Sign In (esta
apagado na Figura 1-34 pois os campos necessarios ainda nao foram
preenchidos).

3. Uma vez conectado, vocé recebera a URL exclusiva que permite que ou-
tros vejam a sua tela, como mostrado na Figura 1-35. O Adobe Connec-
tNow automaticamente define a URL com base em seu nome. Se vocé
quiser muda-la, clique no link Customize Your Meeting URL. Também ha
um link que cria convites via e-mail para enviar as pessoas que vocé quer
gue se juntem a sessao.

4. Quando vocé clica no botao Close, o ConnectNow abre seu navegador. Se
esta for a primeira vez em que vocé participa de uma sessao utilizando o
ConnectNow ou a versao paga Connect, pode ser solicitado a vocé instalar
um plugin especial. Isto é necessario para o compartilhamento de tela
funcionar. Normalmente deve ser um processo bastante rapido.

5. Logo que o navegador tiver conectado com sucesso ao ConnectNow, ele
abre a tela mostrada na Figura 1-36. Esta € sua sala de recepgao online,
gue na verdade é um aplicativo que funciona no Adobe Integrated Runti-
me (AIR).

CTNOW™™

Figura 1-36. A sala de recepcao do ConnectNow permite que vocé controle o que os outros
veem.
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Neste ponto, ninguém pode ver sua tela. A janela do ConnectNow tem um
painel de bate-papo que funciona como um mensageiro instantaneo. No
centro esta um botao rotulado Share My Computer Screen. Antes de clicar
nele, vocé deve estar avisado que uma vez iniciado o compartilhamento
de tela, os outros participantes serao capazes de ver tudo em sua area de
trabalho, ndo apenas o Dreamweaver. Entdo, certifique-se de que nado ha
nada la que vocé nao queira que sua mae ou o coletor de impostos vejam.
Vocé pode minimizar a tela do ConnectNow para organizar as coisas, caso
necessario.

6. Quando seus convidados acessarem sua URL pessoal, sera solicitado a se
inscrever como convidados ou utilizando uma Adobe ID. Uma vez inscritos,
serdo recebidos com uma tela dizendo a eles que a conferéncia é privada
e que uma mensagem foi enviada ao anfitriao.

Como anfitrido, uma janela irad surgir na parte inferior da sua tela, infor-
mando que o Mickey Mouse, Bill Gates ou seja la quem vocé convidou
gostariam de permissdo para ingressar. Quando vocé aceitar, as outras
pessoas veem a mesma janela do ConnectNow da Figura 1-36. Novamen-
te, pode ser necessario instalar um plugin caso seja a primeira vez em que
o convidado acessa uma sessao do Connect ou ConnectNow.

7. Quando vocé estiver pronto para compartilhar, cligue Share My Computer
Screen. Sera solicitado uma confirmacdo de que vocé esta pronto para co-
mecar a compartilhar. Clique Share (ou Cancel, caso vocé nao esteja pronto).
Entdo vocé recebera a rapida mensagem mostrada na Figura 1-37, mostran-
do a diferencga entre o que vocé vé como anfitrido e o que os outros veem.

8. Clique em OK para comecar a compartilhar. Tao logo vocé o fizer, a janela
do ConnectNow encolhe para mostrar apenas uma lista dos participantes
e a janela de bate-papo, expondo o resto de sua area de trabalho, como
mostrado na Figura 1-38. Todos os outros veem sua area de trabalho
emoldurada na secao Screen Sharing da janela ConnectNow maximiza-
da. A Unica coisa que os outros ndo podem ver é sua pequena versdo da
janela ConnectNow. A ndo ser que vocé queira ficar de olho na janela de
bate-papo, provavelmente é uma boa idéia minimizar a janela Connect-
Now enquanto compartilha sua tela.

You are about to share your screen. You will have access to the key meeting features through the screen sharing
palette. Viewers will continue to see the full meeting interface.

Figura 1-37. O anfi- This is what you will see This is what others will see
trido da conferéncia
vé um leiaute de tela

diferente dos outros | [] Banatsha this messsgeagain _

participantes.
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Figura 1-38. Uma vez iniciado o compartilhamento, toda a sua area de trabalho é exposta.

9. Para parar de compartilhar, clique no botao X no topo direito da janela
ConnectNow do anfitrido, como mostrado na Figura 1-39.

10. Para finalizar uma conferéncia, selecione Meeting » End Meeting na
janela maximizada do ConnectNow. Vocé nao pode finalizar uma confe-
réncia enquanto ainda compartilha sua tela. Serd mostrado a vocé uma

Minimize

CONNECTNOW- Screen sharing Stop Sharing

ATTENDEES

[4:10 pm] David Powers: Hi, Mickey, nice of
you to join me for this session

[4:11 pm] Mickey Mouse: Great to be here,
David!

Figura 1-39. Enquanto compartilha, a janela
ConnectNow do anfitrido mostra aos partici-
pantes, uma janela de bate-papo e ferramen-
tas para controlar a sessao.
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mensagem de despedida sugerida, que vocé pode editar ou simplesmen-
te enviar como esta para todos os participantes. Assim que a conferéncia
tiver terminado, feche a janela ConnectNow.

Isto foi apenas uma visdo rapida do compartilhamento de tela. A melhor
forma de descobrir mais é experimentar vocé mesmo e abrir o menu Help
dentro da janela do ConnectNow. Como vocé ird descobrir, 0 servigo su-
porta o uso de webcams, conversa por voz via protocolo de internet (VolP)
e conferéncia por telefone. Apesar do servico ConnectNow ser gratuito, a
conferéncia por telefone é cobrada com taxas de longa distancia.

O servico de compartilhamento de tela permite que os outros tomem o controle de
sua tela - se vocé der permissdo para eles primeiro. Isto é muito util e potencial-
mente perigoso. Certifique-se de que conhece a outra pessoa antes de dar a ela o
controle do seu computador.

Gerenciando CSXS

Outros servicos hospedados foram disponibilizados apés o langcamento do
Dreamweaver CS4. Para preparéa-lo para eles, hd um novo painel Connections,
mostrado na Figura 1-40. Para abri-lo, selecione Window » Extension » Con-
nections.

0 item Extensions no menu Window é nomeado de forma confusa. Ele nao tem relagcao
com extensées a funcionalidade do programa que tem sido uma caracteristica princi-
pal do Dreamweaver desde a primeira versao. Para instalar as extensées do Dreamwe-
aver, abra o Extension Manager 2 diretamente no menu Iniciar ou no Finder de um
Mac. Alternativamente, utilize Manage Extensions nos menus Commands ou Help.

Se vocé se conectar no painel Connections com sua Adobe ID, o Dreamweaver
automaticamente ira verificar o servidor por atualizacoes para o CSXS e insta-
|a-las. Se vocé quiser desabilitar este comportamento padrao, clique no botao

<— Menu de Opgoes do Painel

CONNECTIONS -

Use your Adobe ID to access Adobe
Services.

Don't have an Adobe ID?
Create an Adobe ID.

Email address: {your Adobe ID)

Password:

Forgot your Adobe ID or Password?

O me on this c

Selecting this will automatically log you
in to Adobe web services.

Log In

Figura 1-40. O painel Connections serve para fornecer acesso aos servicos hospedados
futuramente.
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do menu de opg¢des do painel no topo direito do painel, como mostrado na
Figura 1-40. O item Update preferences do menu permite a vocé escolher se o
Dreamweaver automaticamente verifica as alteracoes e as instala. O item Offli-
ne options do menu permite que vocé escolha manter-se offline. Selecionar
esta opgao desabilita a funcao Share My Screen descrita na secao anterior.

Outras novas funcoes

Além das funcdes CSXS ja descritas, as seguintes fungdes foram adicionadas
ou alteradas de forma significativa.

m Extrator JavaScript: identifica todos ou a maioria dos JavaScript em uma
pagina web e move-os para um arquivo externo. Seu uso é descrito no
Capitulo 8.

m Conjuntos de dados Spry: a interface para criar conjuntos de dados Spry
foi totalmente redesenhada. Agora ela gera conjuntos de dados a partir de
fontes HTML bem como XML. Seu uso é coberto no Capitulo 19.

m Novas widgets Spry: quatro novas widgets Spry foram adicionadas. Trés
delas lidam com a validacao de elementos de formulario (grupos de botao
de radio, campos de senha e campos de confirmacado de senha). Estas
sdo cobertas no Capitulo 9. A outra widget cria dicas e rollovers desconec-
tados e é coberta no Capitulo 7.

m Integracao com Subversion: o Subversion (http://subversion.tigris.org/)
é um dos sistemas de controle de versao de cédigo aberto mais popula-
res. O Dreamweaver agora fornece acesso direto ao repositério do Subver-
sion através do painel Files. Esta funcgao é descrita no préximo capitulo.

m Ocultacao de arquivos individuais: a oculta¢ao exclui certos arquivos de se-
rem enviados para o servidor remoto. Nas versoes anteriores do Dreamwe-
aver, o ocultamento estava restrito a todos os arquivos com uma extensao
especifica e diretérios (pastas) inteiras. Vocé agora pode ocultar arquivos
individuais também. O ocultamento é coberto no préximo capitulo.

Uma melhoria relacionada exclui os arquivos ocultados dos relatérios so-
bre arquivos 6rfaos (arquivos que ndo possuem links direcionados a eles).
Para executar uma verificagdo por arquivos 6rfaos, selecione Site > Check
Links Sitewide. Quando a aba Link Checker abrir no grupo do painéis Re-
sults, escolha Orphaned Files a partir do menu Show no topo esquerdo do
painel.

m Smart Objects do Photoshop: a integracdo com o Photoshop foi melhora-
da adicionando-se suporte aos Smart Objects (imagens conectadas dire-
tamente ao arquivo original do Photoshop). Isto é coberto no Capitulo 3.
O Dreamweaver nao suporta Smart Objects importados de outros progra-
mas da Creative Suite, como o lllustrator.

m Inserindo videos Flash e Flex: A forma como os videos Flash e Flex sdo
incorporados a pagina web foi alterada. Paginas criadas com o Dreamwe-
aver CS4 utilizam o novo método, que inclui um instalador expresso que
atualiza a versado do Flash Player caso necessario. Paginas criadas nas
versoes anteriores do Dreamweaver nao sao atualizadas, mas podem ser
editadas sem problemas. Veja o Capitulo 3 para detalhes.

m Edicao contextual: este € um servico online hospedado pela Adobe que
permite aos usuarios autorizados editar paginas web através de um nave-
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gador web. O que pode ou nao ser alterado é determinado pelo desenvolve-
dor criando regioes editaveis e definindo regras através do Dreamweaver
CS4. A edicao contextual € coberta no Capitulo 13.

m Ajuda online: a maioria dos arquivos de ajuda do Dreamweaver agora
estd hospedada online. Quando vocé acessa Dreamweaver Help a partir
do menu Help (ou pressiona F1), o Dreamweaver detecta se vocé esta on-
line e abre o sistema de ajuda em seu navegador padrao. A Adobe diz que
adotou este sistema para que o contelido possa ser atualizado e corrigido
mais facilmente, caso necessario. Um conjunto limitado de arquivos de
ajuda esta incluso no programa para uso quando vocé esta offline.

0 novo campo Busca por ajuda no Barra do Aplicativo também abre a
ajuda online do site da comunidade relevante. A busca € equipada pelo
Google, mas a Adobe monitora o conteldo para certificar-se de que ape-
nas artigos confiaveis sejam referenciados.

Um desapontamento consideravel foi expresso por muitas pessoas quanto
a falta de novas funcdes para PHP e outras tecnologias do lado do servidor
quando a versao beta publica do Dreamweaver CS4 foi langada em maio de
2008. Este desapontamento € compreensivel, ja que os comportamentos de
servidores continuaram basicamente iguais desde que o Dreamweaver MX foi
lancado em 2002. Falando pessoalmente, meu desapontamento é mais do
que compensado pelas outras mudancas do Dreamweaver CS4. Como eu dis-
se no inicio desde capitulo, considero esta a atualizagdo mais significa do pro-
grama desde o Dreamweaver MX. Fazendo com que mudancas significativas
as funcoes do lado do servidor significassem deixar outras fungdes ou arriscar
implementacdes mais problematicas.

Entretanto, ndo é verdade dizer que nada mudou em relagédo ao suporte PHP.
As dicas de codigo PHP foram limpas adicionando-se novas fun¢des PHP 5 e
removendo itens incorretos e desaprovados. Mudangas também foram feitas
em alguns codigos de comportamento de servidor para garantir que ele nao
quebre com o PHP 6. As mudancas podem parecer pequenas, mas sao im-
portantes; eles também as fizeram de modo a manter a compatibilidade com
paginas desenvolvidas em versoes anteriores do Dreamweaver.

0 que nao esta mais la

A Adobe deu um passo incomum anunciando mais de um ano antes do lan-
camento do Dreamweaver CS4 que certas funcdes seriam removidas. Caso
vocé tenha perdido o andlincio e ndo possa encontrar algumas de suas fungoes
favoritas, aqui esta uma lista do que foi removido.

Modo Layout

Timelines

Elementos, botoes e texto Flash

Mapa do site

Comportamentos de servidor e recordsets ASP.NET e JavaServer Pages
(JSP)

m JavaBeans

m Painel Web Services

A remocao de alguns destes itens provavelmente ira irritar algumas pessoas,
mas as primeiras trés foram removidas no interesse de criar paginas web mais
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compativeis com os padrées. O modo Layout e as timelines geravam cédigos hor-
rendamente complexos que nao tem mais lugar em um website moderno. Adicio-
namento, os elementos Flash criados pelo Dreamweaver eram criados de forma
grosseira e tornavam os websites inacessiveis. A remogao deles nao significa que
vocé nao possa mais utilizar elementos Flash no Dreamweaver - simplesmente
que vocé precisa construi-los no Flash; o Dreamweaver nao os criara para voce.

A decisdo de remover o suporte ao ASP.NET e JSP é mais controversa, mas
parece que deve-se ao reconhecimento da Adobe de que era lutar uma bata-
Iha perdida tentar dar suporte a cinco tecnologias do lado do servidor. Sera
interessante ver qual a aproximacgao ela tomara ao suporte do lado do servidor
nas versoes futuras.

Alterando as configuracoes padrao

Além das fungdes ja descritas, o Dreamweaver possui diversas outras preferén-
cias que podem ser configuradas para se adequarem ao seu fluxo de trabalho. A
configuracao padrao é 6tima para a maioria das pessoas, mas se vocé quer alte-
rar a aparéncia ou forma de trabalhar do Dreamweaver - e isto ja ndo tenha sido
coberto neste capitulo - o primeiro lugar para procurar € no painel Preferences
(veja a Figura 1-41), que vocé acessa a partir do menu Edit na versao Windows e
no menu Dreamweaver no Mac. O atalho de teclado é Ctrl+U/Cmd+U.

Como vocé pode ver na Figura 1-41, o painel Preferences contém 19 catego-
rias, 0s homes das quais bastante auto explicativos. Elementos AP controlam
a aparéncia de elementos <div> absolutamente posicionados, referenciados
nas versoes anteriores do Dreamweaver como layers. Apesar do posicionamen-
to absoluto do CSS poder ser Gtil, muitos usuarios inexperientes confundiam
a interagao entre as layers do Dreamweaver e outros elementos de paginas,
entdo o uso delas agora é geralmente desencorajado.

Descreverei as categorias mais importantes no momento apropriado nos capi-
tulos seguintes. Aqui, irei apenas tocar em outras categorias importantes nao
se adequam naturalmente em nenhum outro lugar.

Preferences {—i'-J
Category General
:;[EISET_:];I:FS Document options: || Show Welcome Screen
Cnga Coloring Reopen documents an startup
Code Format
Code Hints | Warn when opening read-only files
EEE;E:?&!W /| Enable Related Files
C55 Styles Update links when moving files:  |Prompt -
File Compare -
File Types / Editars Editing options: [] Show dialog when inserting objects
Eliognhtﬁghﬁng | Enable double-byte inline input
Invisible Elements /] Switch to plain paragraph after heading
New Document
Preview in Browser Allow multiple consecutive spaces
gltt.:tus aar /| Use <strong> and <em= in place of <b> and <i>
Validator /| Warn when placing editable regions within <p> or <h1>-<h6> tags

Centering: @ Use <div> tag Use <center> tag
Maximum number of histary steps: 50
Spelling dictionary: |English {american) -
Figura 1-41. O painel
Preferences controla a
maioria dos aspectos
Help ok || cancel | da aparéncia e forma de
funcionar do Dreamwe-
aver.
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m Code Coloring: permite que vocé edite o esquema de cores para colorir a
sintaxe para diferentes tipos de documentos e codigos.

m Code Format: uma das configuracdes mais importantes nesta categoria
permite que vocé opte por recuar o codigo para facilitar a leitura ou utilizar
espacos e tabulagdes para o recuo. Se vocé achar que sua pagina web
estd com espagamento incomum, verifique que o Like break type esteja
configurado em LF (Unix). Esta é a configuracdo mais confiavel mesmo
que vocé esteja trabalhando com Windows ou Mac.

m Fonts: controla o tamanho padrao e o estilo das fontes na visualizagao De-
sign e Code. Por padrao, o Dreamweaver utiliza Unicode (utf-8). Se vocé utilizar
uma codificagao diferente para suas paginas, precisa selecionar a apropriada
a partir da lista Font settings. O Dreamweaver chama a codificagao Latin-1
(is0-8859-1) de Western European no Windows e Western no Mac.

Migrando snippets e outras configuracoes
pessoais

Mover sua colecao de snippets, leiautes de espaco de trabalho ou favoritos
envolve simplesmente copiar e colar um arquivo ou pasta de seus arquivos de
configuracao do Dreamweaver.

Localizando os arquivos de configuracao do
Dreamweaver

Os arquivos de configuracao do Dreamweaver estao ocultos no Windows, en-
tao vocé precisa habilitar a opgao para visualizar arquivos e pastas ocultadas
para localiza-los, como segue.

m No Windows Vista, selecione Iniciar » Computador » Op¢oes de Pasta e
Busca » Visualizar. Em Configuragoes Avancadas, escolha Mostrar arqui-
VoS e pastas ocultas.

m No Windows XP, selecione Iniciar » Meu Computador » Ferramentas
» Opcoes de Pasta » Visualizar. Em Configuracoes Avancadas, escolha
Mostrar arquivos e pastas ocultas.

Uma vez ativada esta opcao, as pastas ocultas sdo mostradas como icones
esmaecidos para lembrar vocé de trata-los com carinho.

O Dreamweaver CS4 cria pelo menos trés pastas de configuragdo em seu com-
putador. Duas delas controlam a forma como o programa funciona para todos
no computador. No Windows, estao localizadas em Arquivos de Programas; em
um Mac, estdo em Applications. Vocé ndo deve tentar mexer nelas a ndo ser
que saiba o que esta fazendo. Se vocé cometer um erro, o Dreamweaver pode
parar de funcionar completamente.

Cada vez que o inicia, o Dreamweaver procura outra pasta de configuragao que
armazena as configuragdes pessoais de cada usuario. Editar esta pasta é re-
lativamente inofensivo. Pois uma pasta separada é criada para cada conta de
usuario no computador e alterar suas proprias configuragées nao afetam a de
mais ninguém e vice-versa. Mesmo que vocé faga um bagunca completa das
coisas, basta apagar a pasta e todos os seus contelidos. Se o Dreamweaver



O NOVO VISUAL DO DREAMWEAVER — MAIS DO QUE SUPERFICIAL

nao puder encontrar suas configuracdes pessoais, ele cria uma nova pasta de
configuracao carregada com todas as configuracoes padrao.

O localizacao da pasta de configuracao pessoal depende de seus sistema ope-
racional e da versao do Dreamweaver. Para o Dreamweaver CS4, é a seguinte:

m Windows Vista: C:\Usuarios\<nome do usuario>\AppData\Roaming\
Adobe\Dreamweaver CS4\<idioma>\Configuration

m Windows XP: C:\Documentos e Configuracdes\<nome do usuario>\Da-
dos do Aplicativo\Adobe\Dreamweaver CS4\<idioma>\Configuration

m Mac O0S X: Macintosh HD:<nome do usuario>:Library:Application
Support:Adobe:Dreamweaver CS4:<idioma>:Configuration

Em todos os casos, <nome do usuario> € o nome de sua conta de usuario no
computador e <idioma> indica o idioma de seus sistema operacional. O idio-
ma normalmente é representado por dois pares de caracteres separados por
um underline, como em en_US (inglés), es_ES (espanhol) ou fr_FR (francés).

Versoes anteriores do Dreamweaver localizavam a pasta de configuragao pes-
soa em uma localizagdo um pouco diferentes. Aqui € onde ela pode ser encon-
trada no Dreamweaver CS3:

m Windows Vista: C:\Usuarios\<nome do usuario>\AppData\Roaming\
Adobe\Dreamweaver 9\Configuration

m Windows XP: C:\Documentos e Configuracoes\<nome do usuario>\Da-
dos do Aplicativo\Adobe\Dreamweaver 9\Configuration

m Mac O0S X: Macintosh HD:<nome do usuario>:Library:Application
Support:Adobe:Dreamweaver 9:Configuration

Migrando snippets

O Dreamweaver faz um servigco muito bom migrando definicoes de uma versao
existente do Dreamweaver para uma nova localizada no mesmo computador
(migra-las para outro computador é coberto no préximo capitulo), mas isto dei-
xa para tras qualquer snippets que vocé tenha instalado. (Como o nome suge-
re, snippets [fragmentos] sdo segdes curtas de codigo Util ou utilizados com
frequéncia prontas para serem inseridas em uma pagina).

Para migrar os snippets de uma versao do Dreamweaver para outra, feche o
Dreamweaver e abre sua pasta de configuragdes pessoal da versao que con-
tém os snippets. Dentro, vocé deve encontrar uma pasta chamada Snippets.
Simplesmente copie-a com todo o contelido e cole-a em sua pasta de con-
figuracoes pessoal da nova versao do Dreamweaver. Quando vocé iniciar o
programa, seus snippets estarao prontos para uso.

Transferindo leiautes de espaco de trabalho

Como mencionado anteriormente, vocé pode transferir seus leiautes de es-
paco de trabalho de um computador para outro. Os leiautes de espaco de
trabalho do Dreamweaver CS3 sao diferentes do CS4, entdo vocé nao deve
tentar mistura-los.

Seus leiautes de espacgo de trabalho estao armazenados em sua pasta de
configuragoes pessoal, em uma pasta chamada, logicamente, Workspace. Os
arquivos possuem o0 mesmo nome que vocé utilizou para salvar o leiaute. Sim-
plesmente copie-os na pasta Workspace na outra versao e reinicie o Dreamwe-

53



THE ESSENTIAL GUIDE TO DREAMWEAVER CS4 CSS, AJAX AND PHP

54

aver. Sendo que os arquivos sao escritos em XML, vocé pode compartilha-los
entre usuarios de Windows e Mac.

Movendo favoritos

Assim como na migracao de leiautes de espaco de trabalho, altera¢ées entre o
Dreamweaver CS3 e CS4 significam que vocé nao deve tentar migrar seus favo-
ritos da barra Insert de uma versao para outra. Entretanto, se vocé quiser mover
sua categoria Favorites do Dreamweaver CS4 de um computador para outro, copie
insertbar.xml da pasta Objects da sua pasta de configuragoes pessoa de um com-
putador para o mesmo local no outro computador. Se o computador alvo nao tiver
uma pasta Objects dentro de sua pasta de configuragcoes pessoal, crie uma.

Solucionando erros misteriosos do
Dreamweaver

A secao anterior descreveu como encontrar sua pasta de configuragoes pes-
soal, para o propdésito de migrar configuragdes pessoais. Outro arquivo nesta
pasta costuma ser fonte de alguns erros inexplicaveis no Dreamweaver.

Para acelerar sua operacao, o Dreamweaver cria um arquivo chamado WinFi-
leCache-*******%* dat no Windows e MacFileCache-******** dat no Mac
0S X (0 ******** representa uma série de nimeros e letras). Ocasional-
mente, este arquivo fica corrompido, fazendo com que o Dreamweaver aja
de forma imprevisivel. O problema mais comum é o Dreamweaver mostrar
alertas sobre erros de JavaScript ou sobre “tradutores nao encontrado (trans-
lators not found).” Se isto acontecer, feche o Dreamweaver, dele o WinFileCa-
che-*****%** dat ou seu equivalente no Mac de sua pasta de configuracoes
pessoal e reinicie o programa.

Deletar o arquivo de cache normalmente é suficiente. Entretanto, algumas ve-
zes a causa estd em uma extensdo de outro desenvolvedor que vocé tenha
instalada no Dreamweaver. Se vocé tiver instalado qualquer extensdo, a Gnica
solucdo é desabilitar todas e entdo instala-las uma por uma até poder identifi-
car a culpada (extensao sdo cobertas no Capitulo 8).

Revisao do Capitulo

Esta foi uma turné de maratona da Ul e das novas fungdes do Dreamwea-
ver CS4. Familiaridade com a Ul e fungbes de qualquer programa € essencial
para utiliza-lo com sucesso. A maioria de nds sdo criaturas de habito, entdo
leitores que tenham atualizado de versoes anteriores do Dreamweaver ou mi-
grado de um programa diferentes podem achar o novo ambiente dificil de se
acostumar. O Dreamweaver possui um conjunto de funcionalidades muito rico,
mas nem todos precisam dos mesmos e pouquissimas pessoas precisarao de
todas elas. Experimente diferentes aspectos da Ul e descubra aqueles que se
adequam melhor a vocé.

No préoximo capitulo, cobrirei tudo que vocé precisa saber sobre configurar um
website no Dreamweaver. Se vocé for um usuario experiente do Dreamweaver,
a maior parte sera familiar a vocé, apesar de haver novas funcoes. Se vocé for
novo no Dreamweaver € leitura essencial. Sem uma compreensao do papel da
definicao do site, vocé esbarrara em diversos problemas contornaveis.



